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Website: www.senstar.com

FiberPatrol, Senstar and the Senstar logo are registered trademarks, and Silver Network is a trademark of Senstar Corporation. 
Product names and Company names included in this document are used only for identification purposes and are the property 
of, and may be trademarks of, their respective owners. Copyright © 2019, Senstar Corporation, all rights reserved. 

The information provided in this guide has been prepared by Senstar Corporation to the best of its ability. Senstar Corporation is 
not responsible for any damage or accidents that may occur due to errors or omissions in this guide. Senstar Corporation is not 
liable for any damages, or incidental consequences, arising from the use of, or the inability to use, the software and equipment 
described in this guide. Senstar Corporation is not responsible for any damages, or incidental consequences, that may occur 
due to information about items of equipment or components manufactured by other companies. Features and specifications are 
subject to change without notice.

The figures included in this document are for illustration purposes only, and may differ from the actual equipment.

Compliance

The use of shielded cables is required for compliance.

USA: This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device 
may not cause harmful interference, and (2) this device must accept any interference received, including any interference that 
may cause undesired operation.

Note: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of the 
FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is 
operated in a commercial environment. This equipment generates, uses and can radiate radio frequency energy and, if not 
installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. 
Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to 
correct the interference at his own expense.

Any changes or modifications to the software or equipment that are not expressly approved by Senstar Corporation void the 
manufacturer’s warranty, and could void the user’s authority to operate the equipment.

Europe: 

Conforms to EMC directive 2014/30/EU 

Safety: EN 60950-1:2006 + A2:2013

Service statement - We ensure that our products are correctly applied to achieve the maximum benefits for the end-user. We 
work hand-in-hand with our customers and remain accessible through all stages of a project - from concept to deployment to 
long-term support. We provide design assistance, site surveys, installation support, comprehensive documentation, training, 
post-installation annual calibration and maintenance visits, electronics and software extended warranty, rapid factory repair 
service and on-call/emergency service.
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1 System description

FiberPatrol Overview
The FiberPatrol FP1150 perimeter intrusion detection system detects and locates intruders using 
fiber optic technology. For fence-mounted applications, FiberPatrol senses and locates minute 
vibrations in the fence caused by climbing, cutting, lifting, or otherwise disturbing the fence fabric. 
A fiber optic sensor cable is attached to the perimeter fence. The sensor unit (SU) transmits laser 
light into two single-mode fibers in the sensor cable. The SU picks up the back-scatter reflections 
caused by fence motion or vibrations in the fence fabric and processes the data to determine the 
magnitude and location of each disturbance. The sensor unit triggers an alarm when a disturbance 
meets the criteria for a valid intrusion. One FP1150 SU can monitor up to 80 km of perimeter 
fence.

The FiberPatrol FP1150 can provide covert, buried, long-range protection against third party 
interference (TPI) for buried pipelines or data conduit. In addition, the FP1150 can be configured to 
provide intrusion detection of people and vehicles, or tunneling activity. The FiberPatrol sensor 
detects and locates minute vibrations in the ground. Depending on the application, the burial 
media and the detection settings, FiberPatrol can detect digging, boring, or otherwise disturbing 
the ground near a pipeline’s right of way, as well as nearby vehicles, human intruders and 
tunneling activity. One FP1150 SU can monitor up to 100 km of buried pipeline or data conduit for 
TPI. To detect people or tunneling activity, one FP1150 SU can monitor up to 80 km.

For fence-mounted applications the sensor cable is a communication-grade single-mode fiber 
optic cable intended for outdoor installation. The cable includes two dedicated sensing fibers. 
Depending on the particular fiber optic cable used, at least 10 dark fibers are available for other 
perimeter applications (e.g., CCTV, data communication, etc.). The sensor cable is easily attached 
to the fence with cable ties. However, all fiber connections require fusion splicing to telecom 
industry standards. The sensor unit fiber optic connections use FC/APC type connectors.

For buried applications, and for fence-mounted applications which require additional protection 
against accidental damage and vandalism, the sensor cable is an armored, communication-grade 
single-mode fiber optic cable intended for direct burial in soil. The cable includes a dedicated 
sensing fiber, and a number of dark fibers which are available for other applications. FiberPatrol 
sensor cable requires professional installation using industry standard practices. High quality 
fusion splices are required, and outdoor splices and fiber drop points are protected inside 
weatherproof enclosures which are installed in buried vaults.

One FP1150 SU can monitor different types of sensor cable installations; for example, combined 
fence-mounted and buried cable. In this case, a 30 m (100 ft.) coil of sensor cable is 
recommended to serve as a buffer at the transition between the different installation types. 
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The FiberPatrol system includes Windows-based configuration and alarm display software, which 
is used to setup and calibrate the system. The configuration software enables sensor calibration, 
detection parameter adjustments, system configuration settings and alarm processing. The 
configuration software can also serve as an operator interface to the system for alarm monitoring. 
Optionally, FiberPatrol can run Senstar’s Network Manager Service (NM) software, which supports 
interfacing with security management systems (SMS). 

FiberPatrol can operate as a standalone sensor, which communicates alarm conditions via 
optional relay output modules. A PC-based security management system, such as the Network 
Manager’s Alarm Integration Module, Symphony, or StarNet 2, can serve as the primary operator 
interface for a FiberPatrol system. FiberPatrol can also report alarms to 3rd party security 
management systems (SMS) via the Network Manager Service. The security management system 
monitors the FiberPatrol sensor, and can report alarms to an operator on a graphical site-map.

FiberPatrol sensor system details
• passive, fiber optic, outdoor perimeter intrusion detection system

• uses outdoor-rated telecommunication grade single-mode fiber optic cable for fence protection

• uses armored telecommunication grade single-mode fiber optic cable that is suitable for direct 
burial for buried applications

• uses independent detection parameters for climb intrusions and cut intrusions

• additional dark fibers available for auxiliary perimeter device communications

• single pass coverage for fences up to 4.3 m (14 ft.) high

• no power required for outdoor components

• outdoor components unaffected by lightning, EMI, or electrical transients

• outdoor rated splice enclosures for fiber termination and access to fibers at drop points

• indoor components are rack-mountable in a standard EIA 19 in. equipment rack:

• sensor unit - 4RU component transmits laser light into two dedicated fibers and receives 
and isolates back-scatter signals via the integral start module, analyzes the received 
signal, locates disturbances, triggers alarms, monitors system status, includes Windows 
operating system, FiberPatrol system software and FiberPatrol configuration software

• fiber connection module - 1RU panel for connecting the 2 fiber sensors (S1 and S2) from 
the sensor unit to the lead cable in the equipment room, includes one 12-splice tray for 
making the required fusion splices and a dual end module; a second splice tray can be 
added, if required

• rack-mount LCD keyboard/monitor/mouse combo - 1 RU panel provides control, 
maintenance, calibration and configuration access to the FiberPatrol processor

FP1150 configurations

There are two distinct configurations for the FP1150 Series sensor: 

• Loop configurations in which the two sensors run in opposite directions in one fiber optic 
cable.

• Split configurations in which the two sensors run in opposite directions, in two fiber optic 
cables.

The loop configuration provides single cable cut immunity whereby detection will continue over the 
full length of the perimeter in the event of a single cut in the sensor cable. In the split configuration, 
the two sensors work independently to provide twice the linear length of protection as compared to 
the loop configuration. However, a cut cable ends detection beyond the point of the cut.
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Alarm reporting

The FP1150 Series sensor can be incorporated into any security system, which accepts contact 
closure alarm data. A contact closure based FP1150 Series system can be configured to report up 
to 1440 distinct alarm zones, plus system supervision and fail alarms through UltraLink I/O 
systems. However, contact closure alarm notification does not provide precise target location. The 
FiberPatrol sensor can communicate with security management systems through the Network 
Manager Interface. In this case, the FiberPatrol security perimeter can be displayed on a graphic 
site map as a series of alarm zones (e.g., when a sensor alarm occurs, the zone line flashes to 
identify the alarm’s location). Key features of a FiberPatrol system include:

• user-configurable alarm zone display

• software defined alarm zones enable the redistribution of alarm zones and zone lengths to 
accommodate future changes in security equipment and requirements

• independent detection parameters for cut intrusions and climb intrusions

• fast response time (1 second or less) 

• digital recording of alarm history

• alarm location accuracy typically within 4 m (13 ft.) increases the overall efficiency of the entire 
security system

FP1150 Series Cable length requirements 

Figure 1 FiberPatrol block diagram - fully closed loop redundant configuration

Note The distance reported by the FiberPatrol sensor unit is the optical 
distance of the sensor fiber within the cable. This length is similar to a 
measurement made by OTDR equipment. The optical distance can be 
up to 3% greater than the cable length due to the Helix factor of the 
fiber optic cable.
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The FiberPatrol FP1150 Series sensor system is available in two models, which are based on the 
length of fiber optic cable used, and backward compatibility. The FP115040U provides up to 40 km 
of detection sensing on each of its two sensors (up to 50 km per side for buried TPI applications) 
plus up to 500 m of non-detecting lead cable. Each FP1150 sensor requires an operating license 
(p/n FP-PML-40) that is based on the total length of sensor cable in use (per meter license). To 
change the operating license to cover additional sensor cable length you require a license reissue 
(p/n FP-PML-LU). 

The FP115040H unit is equivalent to the FP115040U unit as described above. The difference 
between the models is that the FP115040H fiber-optic connections are compatible with the 
connections of the FP1100X, FP6100X, and FP1400 units. 

FiberPatrol components
Sensor unit

The FiberPatrol sensor unit generates the laser light signal that is transmitted into the fiber 
sensors. The SU collects the backscatter reflections created by vibrations and analyzes the 
signals to determine the magnitude and location of a disturbance. The SU supports two 
independent fiber optic sensors (S1, S2) and can monitor up to 1440 distinct alarm zones. The 
alarm zones are defined in software, and do not depend on cable length. The SU operates on 100 
to 240 VAC, 50/60 Hz power and can annunicate alarm conditions with the built in IDS software, 
contact closure outputs, or via the Network Manager software. The FiberPatrol sensor unit 
includes 2 SSD RAID hard drives, as well as dual redundant power supplies. There is an audible 
alert that is activated in the event that one of the power supplies fails. A pushbutton switch located 
between the two power supplies silences the alert tone. Figure 2 illustrates a FiberPatrol SU.  

Note To ensure there is enough sensor cable to cover the fence and any 
installation variations, order a 20% overage (e.g., to protect 1 km of 
fence, order 1.2 km of sensor cable). For buried applications, a 5% 
overage is recommended.

Figure 2 FiberPatrol sensor unit front view
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Fiber connection module
The fiber connection module is typically installed next to the SU in the equipment rack and 
occupies 1 RU of rack space. It houses the fusion splices to the two sensor fibers in the lead cable 
(S1 and S2). It includes 2 terminated patch cords that connect S1 and S2 to the SU, and a dual 
end module. The supplied splice tray includes six unused protective sleeves, which are available 
to provide access to dark fibers in the sensor cable. Optionally, a second splice tray can be added 
for making connections to any additional fibers that are being used at the site. Refer to Site 
planning on page 19 for additional details. 

Figure 3 FiberPatrol sensor unit rear view

Figure 4 FiberPatrol fiber connection module
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Outdoor splice enclosure
The outdoor splice enclosure houses all field splices for the FiberPatrol system. The splice 
enclosure is also used to protect the FiberPatrol end module when the end module is installed 
outdoors. The splice enclosure is mounted on the protected fence. For buried applications the 
splice enclosure is protected inside a buried vault. There are 2 models of the splice enclosure 
available. The GM0749-24 splice enclosure can house a maximum of 24 splices and the 
GM0749-48 can house up to 48. 

End module
The end module terminates the laser light signal at the end of each sensor fiber, without causing 
undesirable reflections. There are 2 end modules available, a double end module (FPMA0222) 
and a double end module that is included in the fiber connection module (FPMA0922). The end 
module can be located outdoors in a splice enclosure or indoors in the fiber connection module. 
The location of the end module depends on the sensor cable configuration.

Sensor cable/non-detecting lead cable
For fence-mounted applications, FiberPatrol sensor cable is telecommunication grade single-
mode fiber optic cable with a medium density polyethylene outer jacket and a waterblock system. 
The non-armored loose tube cable is comprised of a 5 unit fiber optic core (12-fiber buffer tubes 

Figure 5 FiberPatrol outdoor splice components

Figure 6 FiberPatrol dual end module
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and PE filler units) a central strength member and a rip cord (see Figure 7). Sensor cable can be 
ordered in lengths of up to approximately 12 km (7.5 mi.) with 12, 24, 36, or 48 fibers. However, to 
facilitate transportation and on-site installation, maximum reel lengths of 5 km (3.1 mi.) are 
recommended. The non-detecting lead cable is identical to the sensor cable, with detection 
sensitivity being controlled via software. For buried cable applications and sites that require 
additional protection against accidental damage or vandalism, armored sensor cable is available 
(see Figure 8).   

Figure 7 FiberPatrol standard sensor cable

Figure 8 FiberPatrol armored sensor cable

Figure 9 FiberPatrol sensor cable/non-detecting lead cable

fiber # color

1
2
3
4
5
6
7
8
9
10
11
12

blue
orange
green
brown
gray
white
red
black
yellow
purple
rose
aqua

designation

S1
S2
dark
dark
dark
dark
dark
dark
dark
dark
dark
dark

blue tube fiber designations

3 mm color-coded 12-fiber buffer tubes

filler tubes

E-glass strength rod

ripcord

MDPE outer jacket

S2 (orange)

S1 (blue)

kevlar filler

11.4 mm OD

with water blocking gel

9/125 µm with 250 µm coating

3 mm color-coded 12-fiber buffer tube

filler tubes

E-glass strength rod

ripcord

S2 (orange)

S1 (blue)

filler

with water blocking gel

9/125 µm with 250 µm coating
MDPE inner jacket

steel armor

MDPE outer jacket

cross section
color coded individual fiber

blue 12 fiber buffer tube

PE filler unit (X 3)

central strength member

binder tape

ripcord (X2)

MDPE outer jacket

waterblock system

orange12 fiber buffer tube



FiberPatrol components

Page 16 FiberPatrol FP1150 Product Guide

Cable ties
FiberPatrol sensor cable can be attached to the fence with stainless steel cable ties, or with Nylon-
12 UV-resistant cable ties. The stainless steel cable ties provide long life and a high level of 
security. A cable tie tool is required to attach the stainless steel ties to the fence. The stainless 
steel cable ties are available with bare metal or vinyl coated in lengths of 20, 36 and 51 cm (8, 14, 
and 20 inches). For situations in which the FiberPatrol cable will be installed on a temporary fence 
and will be redeployed later, UV-resistant polypropylene cable ties are recommended.

Sensitivity loops (fence)

Corner posts, terminal posts and heavy gauge tension posts generally have a dampening effect on 
nearby fence vibrations. To compensate for this, use sensitivity loops at all corner posts, terminal 
posts and heavy gauge tension posts on the fence. The sensitivity loops provide additional sensor 
cable for areas that typically produce lower levels of fence noise (see Figure 30).

Service loops

Service loops provide extra sensor cable for making future repairs, and for making fusion splices. 
On fences, a 10 m (33 ft.) service loop is recommended for every 300 m (984 ft.) of installed 
sensor cable. A 10 m service loop is also recommended on the hinged side of each gate that is 
protected by sensor cable. 
For all applications (buried and fence) a 10 m (33 ft.) splice point service loop is required for each 
section of sensor cable at all splice enclosure locations. A 10 m service loop is typically comprised 
of 5 circular loops of cable with a 60 cm (2 ft.) diameter (see Figure 32). For buried applications, all 
field splices are housed in weatherproof enclosures which are protected inside buried vaults. 

Isolation loops (fence)

Isolation loops are optional, and are recommended for situations where a zone needs extra 
isolation from adjacent zones (e.g., gate isolation). Isolation loops are also recommended as a 
buffer between detecting sensor cable and software defined non-detecting cable. Fence-mounted 
isolation loops use 14 in. steel cable ties to secure 7 loops of sensor cable to the fence. The 7 
loops have a 60 cm (2 ft.) diameter, which requires approximately 13 m of sensor cable (see 
Figure 33).

Transition loops
Transition loops are recommended as a buffer between 2 different installation types (e.g. from a 
fence mounted sensor to a buried sensor). Transition loops are comprised of 30 m (100 ft.) of 
sensor cable which is usually coiled into 15 loops with a 60 cm (2 ft.) diameter. Ideally, transition 
loops are protected inside buried vaults. 

Buried vault
For buried cable applications field splices and terminations are protected inside buried vaults. For 
fences, improved zone to zone isolation can be achieved by installing the optional 13 m (43 ft.) 
isolation loop inside a buried vault. Figure 10 provides the dimensions for the FiberPatrol buried 
vault.
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Figure 10 Buried vault dimensions
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2 Site planning

FiberPatrol configurations
The recommended method for installing FiberPatrol sensor cable is to use the minimum number of 
splices possible (i.e. run a single length of cable from the equipment room to the fence, and 
continue for as far as site conditions will allow you to go). Use splices for the equipment room 
connections, for the end module, for new cable reels, and for any fiber drop points.

Loop configurations

The loop configuration provides single cut cable redundancy for a closed perimeter. The sensor 
unit is located anywhere along the perimeter length with the start and end points of the detecting 
sensor cables co-located on the protected fence. Non-detecting lead cable carries the signal from 
the sensor unit to the start point of the detecting cable. The two sensing fibers S1 and S2 run in 
opposite directions around the perimeter. In the event of a cut or severely damaged sensor cable, 
detection will continue around the perimeter in both directions to the location of the damage. There 
are two types of redundant loop configurations, fully closed and partially closed. Figure 11 provides 
a comparison of the two.

Figure 11 FiberPatrol example fully closed & partially closed configurations

FiberPatrol sensor cable
perimeter fence

administration

administration

fully closed perimeter partially closed perimeter
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The recommended location for the end module is inside the Fiber Connection Module in the 
equipment room. However, if there is a long lead cable run then the blue and orange fibers can be 
spliced to different colored fibers (e.g. green and brown) to make the run back to the equipment 
room. Senstar recommends putting the end modules on the perimeter if the split configuration is 
used, or if the lead cable length was very long, or if there were only two fibers available in the 
home-run cable. 

It is also possible to create a fully closed perimeter without field splices by using the dual end 
module in the fiber connection module in the equipment room. In this case, there are 2 lead cables 
between the equipment room and the perimeter.

Figure 12 FiberPatrol fully closed redundant loop configuration (1 lead cable)

Figure 13 FiberPatrol fully closed redundant loop configuration (2 lead cables)
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In some instances it is desirable to have a single length of cable running between the equipment 
room and the start of the perimeter. This is most common in installations where the sensor unit 
equipment is located a significant distance from the perimeter. In this case, a dual end module is 
located inside a splice enclosure at the start of the perimeter and a single lead cable runs to the 
perimeter fence. S1 and S2 run in opposite directions around the perimeter with both terminated in 
the start point splice enclosure (see Figure 12). 

The partially closed loop configuration uses a dual end module in the fiber connection module in 
the equipment rack. This configuration uses two lead cables and the two sensing fibers (S1 and 
S2) run in opposite directions around the perimeter. The partially closed loop provides single cut 
redundancy. In the event of a cut or severely damaged sensor cable, detection will continue 
around the perimeter in both directions to the point of the damage.

Figure 14 FiberPatrol fully closed redundant loop configuration 
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Split configuration
The split configuration provides extended length coverage by using each sensor fiber 
independently. Pipeline and data conduit TPI cable applications typically use the Split 
configuration. To get the maximum length coverage, the sensor unit is located near the mid-point. 
Two sensor cables run in opposite directions along the perimeter with each end module located up 
to 40 km (25 mi.) away from the sensor unit (up to 50 km {31 mi.} for TPI). One sensor fiber 
provides detection in each direction with S1 running one way and S2 running the opposite way. A 
splice enclosure is required on the fence at the start point to use one lead cable (see Figure 16). 
Using two lead cables eliminates the requirement for a start point splice (see Figure 17). 

Figure 15 FiberPatrol partially closed redundant loop configuration

Figure 16 FiberPatrol split configuration (1 lead cable)
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The split configuration can be used as a fully closed loop by co-locating the two software defined 
start points in a splice enclosure and the two end points in a second splice enclosure. However, 
the split configuration does not provide single cut redundancy. Figure 18 and Figure 19 illustrate 
the split configuration being used as a fully closed loop. 

Figure 17 FiberPatrol split configuration (2 lead cables)

Figure 18 FiberPatrol split configuration (closed loop with start point splice)
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Site survey
The first step in installing a FiberPatrol system is to conduct a detailed site survey. The survey 
assesses the site conditions to determine the specific installation requirements including the burial 
media, or the fence type, fence condition, fence length, zone layouts, sensor cable route, non-
detecting lead cable length, length of sensor cable required to cover the perimeter, and the 
location for the electronic components.

Create a drawing of the site (e.g., CAD drawings), which indicates the locations of:

• sensor unit equipment

• fences (include type and condition)

• gates (include type and size)

• buildings and other structures

• roads, driveways, sidewalks, paths, parking areas

• trees, bushes, dense vegetation (near fence)

• burial media

• sensor cable

• other existing or planned security equipment (e.g., CCTV cameras, security lighting, etc.)

• splices (fiber drop points)

Figure 19 FiberPatrol split configuration (closed loop no start point splice)
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Fences
The fence must be properly installed, tensioned, and maintained, to provide effective intrusion 
detection with FiberPatrol. The fence should be uniform in height and quality, and should be high 
enough to present an effective barrier against climb-over intrusions. It is also recommended that a 
climb-over barrier, such as barbed wire or concertina, be installed along the top of the fence. The 
condition of the fence is critical to the efficient operation of the FiberPatrol sensor system. Breaks 
in the fence structure, or slack portions of the fence fabric, will inhibit the transmission of the fence 
vibrations to the sensor cable. 

Chain-link fences

The chain-link fence fabric should meet the following specifications:

• maximum range of deflection 10 cm (4 in.) when a 22.5 kg (50 lb) force is applied 
perpendicular to the center of a panel (pushing and pulling) (based on 3 m, 10 ft. post spacing)

• minimum height of 2.4 m (8 ft.) with climb-over deterrent hardware securely mounted on top

Weld-mesh fences

A typical weld-mesh fence section consists of 3 mm (0.1 in.) diameter steel wire welded into a grid 
configuration, with horizontal spacing differing from the vertical spacing. These fence sections are 
secured to fence posts and to the adjacent fence panel sections. The sections of weld-mesh fence 
are either welded together or connected using clips, bolts or rivets. The minimum recommended 
height for a weld mesh fence is 2.4 m (8 ft.) and climb-over deterrent hardware should be securely 
mounted on top. All components must be securely connected to prevent any metal on metal 
contact which can be caused by moderate to strong winds. 

Fence height considerations

FiberPatrol will provide a good level of detection for fences up to 4.3 m (14 ft.) high with a single 
pass of cable. The single cable pass is installed at one-half the fence height unless the fence 
includes a middle rail. For fences with a middle rail, the recommended placement of the sensor 
cable depends on the perceived threat. For correctional environments where fences heights are 
typically in the range of 3.6 m (12 ft) or higher and have extensive anti-climb measures in place 
(concertina, etc.), the recommended placement of the sensor cable is 30 cm (1 ft.) below the 
middle rail if one is present. For commercial/industrial environments where fences heights are 
typically less than 3.6 m (12 ft) the recommended placement of the sensor cable is 30 cm (1 ft.) 
above the middle rail if one is present. 

Note Fences used in conjunction with the FiberPatrol sensor must meet 
industry standards for security fences.
If you are not sure of the suitability of your fence for a FiberPatrol 
sensor, hire a local fencing contractor to inspect, and if required, repair 
the fence.

Note Any fence movement which can cause metal-to-metal contact is a 
potential source of nuisance alarms. 
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For instances in which a portion of the fence is covered by a climb-over deterrent (i.e., razor 
ribbon/concertina) the fence height should be based on the uncovered portion of the fence. For 
example, a 5 m (16 ft.) fence with a 90 cm (3 ft.) coil of concertina wire covering the top section of 
the fence should be considered a 4.1 m (13.5 ft.) fence. The concertina wire must be securely 
attached to the fence to prevent any metal on metal contact resulting from environmental 
conditions.  

Climb-over deterrent hardware

Barbed wire

Climb-over deterrent hardware is strongly recommended on perimeter fences under the following 
conditions. Barbed wire outriggers must be secure to prevent movement due to environmental 
conditions. Each barbed wire strand should be taut and tightly secured at each outrigger. The 
outriggers or extension arms attached to post tops should have a tight press-fit/set-screw or be 
spot-welded. Remove or fasten any loose material.

It is possible to install FiberPatrol sensor cable on barbed wire, but extra precautions must be 
taken to avoid damage to the sensor cable. Run the sensor cable along the fence and loop the 
cable up beside the fence posts. Secure the sensor cable to the barbed wire so that the cable 
avoids contact with the barbs. Secure the cable where it crosses each outrigger. Run the cable 
past the outrigger and then back down to the half way height of the fence. Figure 21 shows the 
recommended method for installing sensor cable on barbed wire.

Note Contact Senstar Customer Service for information about using the 
FiberPatrol sensor on fences that are greater than 4.3 m (14 ft.) high.

Figure 20 Recommended fence height/cable pass configurations
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Razor ribbon/concertina

FiberPatrol sensor cable can be installed on a fence that is protected with razor ribbon, providing 
the razor ribbon is secured so that it cannot move due to wind, or other environmental factors. Use 
tensioning wires to secure the coil and to prevent the razor ribbon from separating if it is cut. 
Installing sensor cable directly on the razor ribbon requires special precautions and the use of 
armored sensor cable and steel cable ties. Contact Customer Service if your application requires 
that sensor cable be installed on razor ribbon.

Gates
There are generally two types of gates used with fences, swinging gates and sliding gates. Sliding 
gates must be bypassed, and should be protected by another type of sensor (e.g., a wireless gate 
sensor or a microwave sensor). Swinging gates can be protected by FiberPatrol sensor cable. 
Protected gates should consist of fence fabric attached to a rigid frame that includes horizontal 
and vertical bracing. There are a number of factors that must be considered when planning for 
gates, including whether it’s a single panel or double panel gate and the type of ground beneath 
the gate (for cable bypass). Other gate requirements and concerns include:

Figure 21 Sensor cable installation on barbed wire fence

Figure 22 Razor ribbon
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• firmly attach all gate hardware accessories (minimum free-play)

• make sure that double gates have travel stops (rigid anchors)

• prevent locking hardware from moving in the wind

• prevent sliding gate track hardware, supports, guides, etc., from rattling in the wind

• the direction that the protected gate opens (to the inside, to the outside, or both directions)

• the frequency of gate use

• gate use when the sensor is active (does the gate need to be accessed while the rest of the 
fence is being protected)

Gate bypasses

To get the sensor cable from one side of a gate to the other, the sensor cable is buried below 
ground inside conduit. The sensor cable continues the fence coverage beyond the gate. If site 
conditions make it impossible to dig underground to continue the coverage on the other side of a 
gate, install the cable above ground, over the gate, inside conduit, or on the ground under a 
protective mat. 

Protecting swinging gates with FiberPatrol

To cover a swinging gate with FiberPatrol sensor cable, a cable management kit (p/n FPKT0500) 
is used to protect the sensor cable and allow it to move freely when the gate opens and closes. 
The sensor cable is passed through a section of split conduit that is attached to the fence post that 
supports the gate’s hinges. The sensor cable passes around the outside of the gate panel, 30 cm 
in from the edge of the gate, then passes through the split conduit a second time. The sensor 
cable is routed below ground through conduit, to the other side of the fence, where the fence 
protection continues. All hardware on the gate must be well secured to prevent any metal on metal 
contact while the gate is not in use. Excess sensor cable at a gate location is coiled into a service 
loop on the hinged side of the gate.  

Note Bypassed gates should be protected with another sensor technology.

Figure 23 Gate bypass

Note Creating a service loop on the hinged side of all protected gates is 
strongly recommended.
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For a double swinging gate, both gate panels are protected by sensor cable.

Gate protection for periodically bypassed gates (independent zones)

For a gate that will be used while the system is operational, it is recommended that the gate be 
made into an independent zone. As an independent zone, the gate can be masked so that it does 
not report alarms when it is being used by authorized personnel. The gate zone includes the 
sensor cable on the gate, below the gate, and the two adjacent fence panels on each side. The 
hinged side of each gate should also have a 10 m service loop. In addition, each side of the gate 
can include a 13 m isolation loop to provide a buffer between the adjacent zones. For maximum 
isolation between zones, the isolation loops can be installed in buried vaults (see Figure 27). 
Attach the isolation loops to the fence with cable ties. The isolation loops must be far enough away 
from the gate to prevent the transmission of vibrations into the adjacent zones when the gate is in 
use. The SMS software should be configured to mask alarms from the gate zone when the gate is 
in use (zone accessed/bypassed). 

Figure 24 Cable layout on a single panel swinging gate

Figure 25 Double panel swinging gate
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Determining cable length requirements for gates
1. For each gate panel:

• The sensor cable passes around the circumference of each gate panel at ¼ the gate 
height, 30 cm in from the outside edge, and ¾ the gate height. 
length of cable to protect a gate = 2 X (gate length - 30 cm) + gate height + 2 X (distance 
from inside edge of gate to fence post) + (fence height - 60 cm, for sensitivity loop) + 10 m 
service loop (per gate)

2. To reach the other side of a gate:

• Create a sensitivity loop beside the fence post adjacent to the gate. Run the sensitivity 
loop up to 30 cm from the top of the fence and back down the post to pass through the 
split conduit. Loop the cable around the gate as described in step 1. Pull the cable through 
the conduit to the other side of the gate. The conduit should be buried at a depth of 30 cm, 
and the ends should extend at least 30 cm above ground level. Seal both ends of the 
conduit (water tight).

3. To isolate the gate zone for access/secure operation:

• Add the length of the cable required to cover the two adjacent fence panels on each side 
of the gate) plus two 13 m (43 ft.) isolation loops plus length of cable to reach the buried 
vaults (if used).

Using the cable management kit at the hinged side of protected swinging gates

A cable management kit (p/n FPKT0500) is used at swinging gate locations to protect the sensor 
cable from being caught or pinched by the gate while allowing the cable to rotate freely when the 
gate is opening and closing. The cable management kit includes a 1 m length of split conduit, two 
1.15 m pieces of split loom and two gear clamps. The split conduit is fitted against the fence post 
on the hinged side of the gate, the split loom prevents the cable from rubbing against the edges of 
the conduit and the gear clamps are used to secure the conduit to the fence post. The conduit 
must have notches cut at any points where gate hardware is attached to the post, so the conduit 
can fit flush against the fence post. 

Figure 26 Independent gate zone

Figure 27 Independent gate zone (with buried isolation loops)
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Protecting masonry walls and buildings

If some, or all, of the perimeter is comprised of masonry walls or buildings, FiberPatrol sensor 
cable can be installed along the outside edge, and if necessary, the inside edge of the structure to 
protect against climb over intrusions. In this case, custom P-brackets are used to fasten the sensor 
cable to the structure so it extends slightly outside and above the structure. A P-bracket is installed 
every 50 cm (20 in.) along the structure to hold the sensor cable in place. 

For a masonry wall, the recommended sensor cable configuration uses 2 cables. One along the 
outside edge and one along the inside edge.

Sensitivity loops for heavier gauge posts

Use sensitivity loops at all corner posts, terminal posts and tension posts on the fence. The 
sensitivity loops provide additional sensor cable for areas that typically produce lower levels of 
fence motion. The length of cable required for a sensitivity loop can be calculated using this 
formula: 3 X (fence height - 60 cm) + 90 cm = sensitivity loop cable length requirement. 
For example, on a 2.4 m (8 ft.) fence, the service loop would go down 90 cm, then up 1.8 m, then 
down 1.8 m, and up 90 cm over a horizontal length of 90 cm. 

Note FiberPatrol functions as a contact sensor when it is installed on 
masonry walls and buildings.

Figure 28 Protecting a masonry structure along the perimeter

Figure 29 Protecting a masonry structure along the perimeter
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Service loops

A 10 m (33 ft.) service loop is recommended for every 300 m (984 ft.) of fence-mounted sensor 
cable. A 10 m service loop is also recommended on the hinged side of each gate that is protected 
by sensor cable. In addition, a 10 m (33 ft.) splice point service loop is required for each section of 
sensor cable at all splice locations. A 10 m service loop is typically comprised of 5 loops of cable 
with a 60 cm (2 ft.) diameter. Service loops should be securely attached to the lower section of the 
fence beside a fence post. Attach service loops directly to the fence fabric using one cable tie at 
each 45º point of the loop (8 cable ties). 

Figure 30 Sensitivity loop (heavy gauge post)

Figure 31 Sensitivity loop (corner post)

NOTE: All double arrows indicate 30 cm (1 ft.) separation. All turns must respect the minimum bend radius.

NOTE: All double arrows indicate 30 cm (1 ft.) separation.
All turns must respect the minimum bend radius.
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Isolation loops (optional)

Isolation loops can be used at the start point of detecting cable, on both sides of gates that will be 
setup as independent zones, and at cable bypasses. Isolation loops use approximately 13 m 
(43 ft.) of sensor cable coiled into 60 cm (2 ft.) diameter loops (7 loops) to provide a distinct zone 
demarcation point. Isolation loops can be buried in cable vaults, which will provide the greatest 
level of isolation between two zones. However, if using a buried vault is impractical, isolation loops 
can be attached directly to the fence fabric with 14 in. steel cable ties. Figure 33 shows a cross 
section of a fence-mounted isolation loop attachment and Figure 27 shows the buried vault 
installation method for isolation loops. Isolation loops are attached to the fence in the same 
manner as service loops (see Figure 32). 

Transition loops

A 30 m (100 ft.) transition loop is recommended as a buffer between different installation types. 
For example, at the transition between fence mounted sensor cable and buried cable. A 30 m 
transition loop is typically comprised of 15 circular loops of cable with a 60 cm (2 ft.) diameter. 
Ideally, transition loops can be installed in buried vaults. Otherwise, transition loops should be 
securely attached to the fence beside a fence post. 

Figure 32 Service loop

Figure 33 Isolation loop (fence-mounted)
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Cable bypasses for buildings and structures

If there is a building or other structure along the perimeter, it can be bypassed in the same manner 
as a sliding gate. In some instances, it may be possible to pull the cable through conduit that has 
been embedded in the structure. Otherwise, use the below ground cable bypass method. To 
ensure the bypass cable will not cause alarms, use a 13 m (43 ft.) isolation loop at each end of the 
bypass. The isolation loops can be buried in FiberPatrol vaults (see Figure 36). If this method is 
impractical, the isolation loops can be attached to the fence (see Figure 35 and Figure 37).

Alternatively, the building or structure can be protected by attaching sensor cable to it’s outside 
edge with custom P-brackets (see Protecting masonry walls and buildings on page 31). In this 
case the sensor cable on the structure should be setup as an independent zone. Isolation loops 
are essential in this application due to the extremely different vibration conducting characteristics 
of the fence and structure.  

Figure 34 Transition loop

Note Bypassed sections of perimeters should be protected by another 
technology like a microwave sensor (see Figure 35).

Figure 35 Perimeter structure bypass (through structure)
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Selecting conduit for below ground bypasses
When the sensor cable must go below ground to reach the other side of a gate, or go through or 
below a building or object, the cable must be protected by using conduit. For sites that include 
periods of freezing weather, solid wall conduit is required. For sites in temperate climates that do 
not experience freezing weather, split conduit can be used.    

Figure 36 Perimeter structure bypass (below ground with buried vaults)

Figure 37 Perimeter structure bypass (below ground)

Figure 38 Split wall conduit
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Solid wall conduit
• Both ends of the conduit must be sealed to prevent water from entering the conduit and 

freezing. 

• Flexible conduit can be bent and formed into the required shape for a cable bypass. 

• The minimum bend radius for flexible solid wall conduit is 46 cm (18 in.). (If the conduit is 
kinked during bending it must be replaced.)

• If conduit sections are used, the sections must be glued together (water tight).

• Use conduit sweeps. Do not use 90º elbows. (Cable bend radius rules must be followed.)

• Bury the conduit at least 30 cm (1 ft.) below ground.

Split wall conduit
• Use conduit sweeps. Do not use 90º elbows.

• Bury the conduit at least 30 cm (1 ft.) below ground.

Deploying the sensor cable 

There are two standard methods of deploying FiberPatrol sensor cable. 

1. The cable drum can be mounted on a cable stand and then the cable can be pulled around the 
perimeter.

Figure 39 Conduit fittings

Figure 40 Solid wall conduit

Note Install FiberPatrol sensor cable on the side of the fence that is opposite 
the threat (the secure side of the fence).

water tight rain plugs are required for sites

use cement at joints

which experience periods of freezing temperatures

for solid wall conduit

flexible solid wall conduit is required for areas with freezing temperatures
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2. The cable drum can be mounted on a reel trailer or a truck, which lays out the cable on the 
ground as it moves around the perimeter.

Refer to the site plan and pull back and lay out sufficient sensor cable to cover the site specific 
features (gates, bypasses, service loops, sensitivity loops, isolation loops, fiber access points).

The following factors must be considered when deploying FiberPatrol sensor cable along the 
inside of the perimeter fence: 

• The length of the section of sensor cable being deployed.

• Clearance and access along side the fence.

• Service loops, sensitivity loops, isolation loops, splice loops, gate coverage.

• Site-specific features such as cable bypasses for gates and other structures on the perimeter.

• The location of splices.

Sensor cable splices
At all designated splice points, each section of sensor cable requires a 10 m (33 ft.) service loop. 
The service loops at splice points allow the sensor cable and splice enclosure to be attached to, 
and removed from, the fence fabric for splicing. Inside the splice tray, sensor fibers S1 and S2 and 
any dark fibers that are designated for use must be fusion spliced. When dressing the bare fibers, 
ensure that the turn radius is kept above a minimum bend radius of 32 mm (1.25 in.). Any tighter 
bend radius may lead to optical fiber damage and an increased loss at the splice location.

Sensor cable loss limits
Once the field splices are complete, and the sensor cable is installed, the loss must be measured 
from both ends of the cable to ensure the quality of each splice. The maximum loss for a single 
event is 0.3 dB.

The maximum allowable total span loss including cable loss and splice losses for the 
FP115040U/H when used for perimeter intrusion detection applications is 9.6 dB.

The maximum allowable total span loss including cable loss and splice losses for the
FP115040U/H when used for pipeline or data conduit TPI applications is 12 dB.

The fusion splices in the equipment room and at the end modules are made once the field splices 
have passed the OTDR measurement test.  

Figure 41 Cable splice service loops and buried isolation loop at fully closed perimeter start/end point

 service loops (10 m cable length, 60 cm diameter)

splice
enclosure

conduit

buried 13 m 
isolation loop (optional)
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Site analysis checklist

Cable requirements

Calculating the total length of fiber optic cable required is one of the most important parts of site 
planning. Other equipment requirements, including the necessary software activation license, are 
determined by the length of cable. The following table provides guidelines on how to determine 
how much cable is required. Alternately, the length of cable required can be estimated by the 
following formula:

(lead cable length) + (length of protected fence) + (length of protected fence X 0.2)  

Figure 42 Cable splice service loops and fence-mounted isolation loop at fully closed perimeter start/end point

Description

create a site plan

accurate CAD drawings with precise measurements and/or GPS coordinates

detailed description of fences (type, condition, height, fence rails, climb over 
deterrent hardware, other cables, conduit, or signs attached to fence)

detailed description of gates (type, condition, location, size)

locate all obstacles on site survey

spur fences or fences abutting the perimeter fence 

sidewalks, paths, roads, driveways

buildings, walls and other structures

utilities (sewers, pipes, conduits and electrical cables, etc.)

Note Each FP1150 SU supports up to 500 m of lead cable that does not 
count against the per meter software activation license.

Note Senstar recommends ordering a cable overage of 20% of the protected 
fence length.

 service loops (10 m cable length, 60 cm diameter)

splice
enclosure

conduit

fence-mounted
isolation loop

 (optional)
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Equipment requirements

For the FP1150 Series, the total length of the system (sensor cable length) is the length of active 
sensing cable plus the amount of lead cable that exceeds 500 m. Active sensing cable refers to all 
cable between the starting and ending points including all cable loops, bypasses, etc. The total 
length of sensor cable determines the required software activation license for the FiberPatrol 
system. The per meter software activation license is purchased for sensor lengths up to 40 km for 
perimeter intrusion detection; and up to 50 km for pipeline or conduit TPI applications. 

Other required equipment includes:

• end modules (depending on configuration)

• 1RU rack-mount fiber connection module (for equipment room fiber splices)

• 1RU rack-mount keyboard monitor mouse (optional, for equipment room access to SU)

• outdoor splice enclosure (1 required for each outdoor cable splice, or termination)

• splice consumables kit (each kit includes the components for 24 splices)

• cable management kit (1 required per swinging gate panel for each protected gate)

• stainless steel cable ties, or UV resistant plastic cable ties (1 tie per 50 cm [20 in.] of cable, 
additional ties required for cable loops and outdoor splice enclosures, stainless steel cable ties 
require an installation tool)

• FiberPatrol cable vaults (optional) for buried isolation/transition loops

• conduit for below ground cable bypasses

Feature Description (length unit = meters, single pass coverage) Cable length

lead cable distance from equipment to start of perimeter - 500 m

perimeter length length of protected fence including gates and bypasses

gate coverage length of cable required to protect swinging gates

service loops (protected fence length divided by 300 m + number of 
service loops for gates + number of cable sections going into 
splice enclosures + equipment room service loop) X 10 m

transition loops number of transition loops X 30 m

optional isolation 
loops

number of isolation loops X 13 m

sensitivity loops (1) number of corner posts and heavy gauge tension/support 
posts X 3(fence height - 60 cm)

sensitivity loops (2) (number of heavy posts at gate/obstacle locations) X 2(fence 
height - 60 cm)

cable overage
(fences)

calculated length of cable (above 8 features) X 0.05 (for 5% 
overage)

cable requirement sum of the above 9 features = total cable requirement
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Buried cable applications
FiberPatrol FP1150 Series sensor cable can be buried to provide protection against third party 
interference (TPI) for pipelines and data conduit, above ground intrusion detection, and tunneling 
activity.

Site survey

The first step in installing a FiberPatrol buried detection system is to conduct a site survey. The 
survey assesses the site conditions to determine the installation requirements including the area 
requiring protection, alarm zone layouts, sensor cable route, lead cable length, length of sensor 
cable required, and the location for the electronic components.

Create a drawing (e.g., CAD drawings or a site plan) which indicates:

• the length of pipeline or perimeter that requires protection 

• the number of FP1150 sensor units required to provide the specified coverage

• the location of the sensor unit and control room equipment for each FiberPatrol sensor

• the distance from the sensor unit to the start point of detection for each FiberPatrol sensor

• individual alarm zones

• burial media along the proposed cable path

• buildings and other structures near the detecting cable

• railroads, roads, driveways, sidewalks, paths, parking areas (near the detecting cable)

• trees, bushes, dense vegetation (near the detecting cable)

• location of sensor cable

• other existing or planned security devices (e.g., CCTV cameras, security lighting, etc.)

• fiber drop point locations (for access to dark fibers in sensor cable)
for a fiber drop point you require an outdoor splice enclosure and splice tray, a buried vault and 
a section of conduit with a 90º sweep to bring the fiber optic cable above ground; Figure 43 
illustrates a fiber drop point which includes three 10 m (33 ft.) service loops that are required to 
make the fusion splices

Burial media

The soil in which the sensor cable is buried must be a type that conducts vibrations. Most natural 
types of soil are included. However, extremely loose soil types like sand and gravel do not conduct 
vibrations well and may prevent the sensor from operating efficiently. When conducting the site 
survey, make a note of any locations along the cable route that have loose soil types.

Deploying the sensor cable
Typically, FiberPatrol sensor cable is deployed by mounting the cable drum on a reel trailer or a 
truck, which lays out the cable on the ground as it moves alongside the pipeline. Refer to the site 
plan and pull back and lay out sufficient sensor cable to cover any site specific features (bypasses, 
service loops, fiber access points).

The following factors must be considered when deploying FiberPatrol sensor cable: 

• The length of the section of sensor cable being deployed.

• Clearance and access along the cable route.
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• The location of splices and fiber drop points.

• Site-specific features such as cable bypasses.

Sensor cable splices
At all designated splice points, each section of sensor cable requires a 10 m (33 ft.) service loop to 
provide access to the sensor cable and splice enclosure. Inside the splice tray, the sensor fiber 
and any other fibers that are designated for use must be fusion spliced. When dressing the bare 
fibers, ensure that the turn radius is kept above a minimum bend radius of 32 mm (1.25 in.). Any 
tighter bend radius may lead to optical fiber damage and an increased loss at the splice location. 
Once the field splices are complete, and the sensor cable is installed, the loss must be measured 
from both ends of the cable to ensure the quality of each splice. The fusion splices at the head end 
and the end module are made after the field splices have passed the OTDR measurement test. All 
field splices are protected inside weatherproof enclosures and buried vaults. There are two splice 
enclosures available, one holds a maximum of 24 splices, the other holds up to 48. 

Sensor cable terminations
Each sensor fiber must be spliced to an end module to terminate the detecting sensor cable at the 
ends of S1 and S2. At the end point, the sensor cable requires a 10 m (33 ft.) service loop to 
provide access to the sensor cable and splice enclosure. The fusion splices at the fiber connection 
module and end module are made after the sensor cable has passed the OTDR measurement 
tests from both ends of the cable. Figure 44 shows the recommended field installation of an end 
module. Figure 45 shows the recommended field installation of two end modules for contiguous 
FiberPatrol sensors. In the example for the contiguous sensors, a short length of sensor cable is 
used to splice the dark fibers that are required from one sensor system to the next.  

Figure 43 Example fiber drop point

splice enclosure

10 m service loop

buried vault

ground level

HDPE conduit

fiber optic cable (includes dark fiber)

sensor cable sensor cable

10 m service loop

10 m service loop
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Sensor cable bypasses

In some instances, it may be necessary to bypass an area along the cable path and then continue 
the detection beyond the bypass. A typical situation like this occurs when the cable crosses a road 
(see Figure 46) or if a pipeline must go above ground to get past a river. In either case, the 
detection is disabled in software for the section of cable that must be bypassed. For a road 
crossing, the sensor cable may require protection by conduit that is sealed at both ends. For 
pipeline protection, when the sensor cable goes above ground, it is strapped to the pipe at 1 to 2 m 
intervals. Figure 47 illustrates the method for above ground sensor cable bypasses.  

Figure 44 Single end module installation

Figure 45 Back-to-back end module installation
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Cable requirements
Calculating the total length of fiber optic cable is one of the most critical phases of site planning. 
Other equipment requirements, including the necessary software activation license, are 
determined by the length of cable: 

• calculate the length of sensor cable and determine the software activation license required for 
this application; total cable length includes service loops, lead cable greater than 500 m, plus 
approximately 5% overage of the cable length for installation variations 
e.g., to protect a 140 km pipeline or perimeter, the head end equipment averages 150 m from 
the pipeline:

Figure 46 Sensor cable bypass (road crossing)

Figure 47 Sensor cable bypass (body of water)

Note Each FP1150 SU supports up to 500 m of lead cable that does not 
count against the per meter software activation license.

Feature Description (length unit = meters, single pass coverage) Cable length

lead cable length of cable from equipment room to start of perimeter - 500 m 

length of coverage length of required protection including cable bypasses

service loops at each splice location, and at the sensor unit, each section of 
sensor cable requires a 10 m service loop (total number of 
service loops) X 10 m

cable overage calculated length of cable (above 3 features) X.05 (5% overage 
for installation variations)

cable requirement sum of the above 4 features = total cable requirement

software bypass

conduit sealed at both ends conduit

detection ends 
at bypass

detection continues 
past bypass

pipeline

detection ends

sensor cable

above ground
detection continues

below ground

wire ties

body of water
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1. Estimate cable requirement:
(2 X 80 km = 160 km) and (160 km - 140 km = 20 km) therefore, two FP115040 sensors 
would be sufficient to cover the 140 km.

2. Calculate cable requirement and the required software activation license:
pipeline length = 140 km
distance between head end and pipeline requires 150 m lead cable X 4 = 600 m 
cable splices (10 m X 8 splices = 80 m per cable, 80 m X 4 cables = 320 m) 
5% overage 0.05 X (140 km + 0.6 km + 0.32 km) = 7.046 km
cable/license requirement (140 km + 0.6 km + 0.32 km + 7.046 km = 147.996 km rounded 
up to 148 km) 

Cable installation for pipeline TPI detection

The recommended cable installation for third party interference places the sensor cable at least 
50 cm (20 in.) below the ground’s surface, centered above the protected pipeline. The sensor 
cable should also be at least 50 cm away from the protected pipeline. However, for installations 
where the pipeline is less than 1 m (3.28 ft.) below the surface, the sensor cable should be offset 
slightly to maintain the min. 50 cm below ground and the min 50 cm away from the pipe (see 
Figure 62:). In addition, for pipelines that have an existing run of fiber optic cable beside them, the 
cable can often be retrofitted for the FiberPatrol sensor. 

Cable installation for intrusion detection (above ground) 

The recommended cable installation for above ground intrusion detection of human targets and 
vehicles requires a cable burial depth of between 30 and 45 cm (12 and 18 in.) below ground level 
(see Figure 63:). There are a number of factors to consider including the burial media along the 
cable path, moisture content of the soil, and ground frost in the winter. The burial depth should be 
consistent for the full length of the sensor cable.

Cable installation for tunneling detection

To detect tunneling activity, the sensor cable should be buried at least 2 m (6.5 ft.) below ground. 
The deeper burial depth is necessary to prevent nuisance alarms caused by vibrations generated 
by above ground activity. A burial depth of 2 m can detect tunneling activity up to 20 m below the 
sensor cable (see Figure 64:). If it is expected that the tunnel will be deeper than 20 m, the sensor 
cable’s burial depth should also be deeper. 

Figure 48 Example length calculation drawing
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FP115040 control equipment (X 2)
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Alarm communication

Due to the distributed nature of the control equipment in most long range buried sensor 
applications, the alarm communication and reporting is usually performed at a central facility. The 
FiberPatrol IDS software includes an alarm display and control application for local alarm 
annunciation. For remote alarm reporting, FiberPatrol’s alarm communications are managed by 
the Network Manager Service (NM). It is also possible to use the available dark fibers in the sensor 
cable for alarm communication applications. 

Equipment requirements

The total length of the fiber sensors (S1 and S2) in the fiber optic sensor cable (sensor cable and 
lead cable) determines the software activation license required for the FiberPatrol system.

Other required equipment includes:

• one or two dual end modules (depending on configuration)

• 1RU rack-mount fiber connection module (for head end fiber splices) includes dual end 
module

• outdoor splice enclosure (1 required for each outdoor cable splice, or termination)

• splice consumables kit (1 per 24 cable splices)

• FiberPatrol cable vault for each outdoor splice location

• Network Manager Service software

• Security Management System equipment and software

Dark fibers

Depending on the specific cable used for the installation there can be up to 22 dark fibers available 
for other applications (e.g., communications, CCTV). When planning a FiberPatrol sensor system, 
some consideration should be given to the available dark fibers and their potential uses. All dark 
fibers that will be used for other applications must be fusion spliced along with the sensor fibers.
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3 Installing FiberPatrol

Installation on fences

There are ten steps required to complete a FiberPatrol fence-mounted installation:

1. Create a detailed site plan.

2. Deploy the sensor cable alongside the fence according to the site plan. 

3. Attach the sensor cable to the fence.
Pull the cable through bypass conduit, if required.
Make service loops, isolation loops and sensitivity loops, where required.
Attach cable to protected gates.

4. Make the field splices (excluding the splices required for the sensor unit and end modules). 

5. Use an OTDR to measure the loss in each fiber (S1, S2) from both ends of the sensor cable.

6. Install and connect the sensor unit equipment in the control room.

7. Make the fusion splices for the sensor unit and end modules.

8. Set up and configure the system software.

9. Calibrate the system.

10. Test the system to ensure it meets the site’s detection requirements.

Laser light safety

Note The FiberPatrol sensor cable is easily attached to the fence. However, 
the fusion splices require qualified personnel who are trained and 
certified in fiber optic cable splicing to telecom industry standards.

WARNING

FiberPatrol operates with Class 1 laser light levels. The laser light is 
invisible to the human eye, but can still cause eye damage.
NEVER look directly into the end of a fiber connector.
Ensure that the fiber optic light source is off, BEFORE using a scope to 
check a fiber optic connector.
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Optical fiber safety

Fiber optic cable handling

FiberPatrol standard sensor cable performance specifications

The following manufacturer’s performance specifications apply to Senstar’s FiberPatrol sensor 
cable:

• Fiber count (typical) 12, 24, 36, or 48

• Fiber type single-mode

• Fiber wavelength 1550 nm

• Maximum attenuation at 1550 nm of 0.25 dB/km

• Smallest allowable bend radius (dynamic) 22 cm (8.66 in.)

• Smallest allowable bend radius (static) 11 cm (4.33 in.)

• Smallest allowable bend radius (single fiber) 32 mm (1.25 in.)

• Maximum allowable tensile rating during installation 2,700 N (600 lbf)

• Crush resistance (short term) 220 N/cm (125 lbf)

• Temperature ratings (storage) -40 to 75ºC (-40 to 167º F)

• Temperature ratings (installation) -30 to 60ºC (-22 to 140º F)

• Temperature ratings (operation) -40 to 70ºC (-40 to 158º F)

• Typical outside diameter (may vary with cable type) 11.2 mm (0.44 in.)

• Cable weight (may vary with cable type) 75 kg/km (50 lb/1,000 ft.)

Additional cable requirements

• central strength member

• water blocking tape

• gel filled buffer tubes

• rip cord

Cable loss limits (maximum attenuation)

WARNING

Use care when working with exposed optical fibers. The bare fibers are 
125 microns in diameter and can easily penetrate skin.
Always wear safety glasses when working with optical fibers.
Always dispose of bare fibers in a sealed and labeled container that is 
specifically designed to contain fiber optic waste.
NEVER dispose of bare fibers in a standard waste receptacle.

Note Standard FiberPatrol cable (p/n FPSP04XX - XX = number of fibers) 
typically includes 12, 24, 36, or 48 optical fibers inside 1, 2, 3, or 4 gel 
filled buffer tubes. The number of tubes and the number of fibers inside 
each tube may vary, depending on the specific cable used at the site. 
However, the basic cable construction and specifications are fixed 
regardless of the number of tubes/fibers.

Note Test the fibers from both ends of the cable before splicing the fibers in the 
fiber connection module and end module.
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After being fully attached to the fence, each fiber sensor must be tested using an OTDR operating 
at 1550 nm. Measure the loss from both ends of the cable, and use the higher of the two readings. 

• The maximum allowable total span loss including cable loss and splice losses for the 
FP115005U/H is 4.8 dB.

• The maximum allowable total span loss including cable loss and splice losses for the 
FP115040U/H when used for perimeter intrusion detection applications is 9.6 dB.

• individual event loss limit < 0.3 dB

Cable handling recommendations

• Bend management systems must be used to restrict cable bend during installation so that the 
minimum bend radius is not exceeded. (Cable pulleys of a suitable diameter must be used at 
points where the cable changes directions during installation.)

• Fused swivels and tension controlled hauling winches must be used to ensure the cable is 
installed at a tension that does not exceed the specified limits.

• Cable spools must be positioned to limit cable bending and minimize the angle of cable pay-off 
during unwinding/hauling.

• Cable spools must be held firmly in the pay-off stands to ensure smooth rotation and prevent 
any vibration which can damage the drum and the cable.

Illustrated installation recommendations
• Attach the sensor cable to the fence fabric with cable ties at the junction of 2 fence wires. 

Space the cable ties 50 cm (20 in.) apart. 

• Attach the sensor cable at both sides of each fence post about 25 cm (10 in.) away from the 
post. Ensure the cable is snug against the fence post, but is not pulled tightly and stressed. 

Note Fusion splice performance typically results in a loss of between 0.01 and 
0.03 dB.

Figure 49 Cable tie spacing on fence fabric

Figure 50 Cable tie spacing at fence posts

50 cm (20 in.)attach the sensor
cable at the junction

of 2 fence wires

cable tie spacing

25 cm (10 in.)25 cm (10 in.) 50 cm (20 in.)50 cm (20 in.)
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• For all cable turns attach the cable to the fence fabric at each 45º point of the curve.  

• Ensure that the minimum bend radius (dynamic and static) is not violated during or after 
installation.

Figure 51 Cable tie spacing around corners

Figure 52 Static and dynamic bend radius limits

50 cm (20 in.)

secure cable at any
changes in direction 
with a cable tie at 
each 45º point

11 cm (4.3 in.)
min. bend radius

smallest allowable bend
radius for installed sensor
cable = 11 cm (4.33 in.)

smallest allowable bend
radius when installing sensor
cable = 22 cm (8.66 in.)
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• Attach service loops beside a fence post on the lower section of the fence using cable ties at 
each 45º point of the loop  

• Attach isolation loops beside a fence post on the lower section of the fence using cable ties at 
each 45º point of the loop 

Figure 53 Service loops

Figure 54 Isolation loops

service loops require
five 60 cm cable loops
(10 m of sensor cable)

60 cm
(2 ft.)

diameter

attach service loops
with cable ties at each
45º point around the loop 

isolation loops require
seven 60 cm cable loops
(13 m of sensor cable)

60 cm
(2 ft.)

diameter

attach isolation loops
with cable ties at each
45º point around the loop 
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• Buried vault installation details

• burial depth - flush with ground surface 46 cm (18 in.) (dig a deeper pit for below ground 
vault)

• pit dimensions (nominal) - 51 cm (20 in.) deep X 76 cm (30 in.) wide X 107 cm (42 in.) long

• gravel layer - to depth of conduit entry points 13 cm (5 in.) nominal (plus 5 cm (2 in.) gravel 
layer on the bottom of the pit)

• sand layer - pour sand over cable, splice enclosure and gravel layer to completely fill the 
vault

• conduit entry points - cut holes at cable entry points; 4.3 cm (1.7 in.) minimum hole size 

• For instances where the cable must be unreeled and pulled back to accommodate site specific 
installation requirements (e.g., service loops, gates, bypasses) lay the cable on the ground in a 
large figure 8 pattern to prevent twisting or kinking. Never lay the cable in a circular roll.

Note Conduct the OTDR cable testing BEFORE filling the vault with sand.

Note The conduit must be sloped at a slight downward angle (app. 15º) as it 
enters the vault. Otherwise, the conduit ends must be sealed to prevent 
water ingress.

Figure 55: Buried vault isolation loop recommendations

Figure 56 Laying cable in a figure-8 pattern

13 m (43 ft.) 

no strain on cable
at entry/exit point

min. 15º angle for 

isolation loopsand fill

clear crushed stone conduit entry
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FiberPatrol sensor cable and below ground bypasses

FiberPatrol sensor cable typically passes through conduit that is buried below ground to get from 
one side of a gate to the other. There are several techniques that can be used to pull the cable 
through conduit. The best method to use depends on a number of site specific factors:

• the local climate, if the site has a temperate climate and the ground never freezes, split conduit 
can be used to protect the sensor cable

• in areas where ground freezing occurs, solid wall conduit must be used; the solid conduit must 
be sealed at both ends to prevent water from entering

• if the cable is being deployed from a cable stand, the cable can be pulled through the conduit 
as it is dispensed

• if the cable is being deployed from a trailer or truck, it will have to be pulled back to pass 
through the conduit

• a sufficient amount of cable must be pulled back for isolation loops, service loops, and gate 
coverage, as required 

FiberPatrol installation
1. Ensure that there is enough sensor cable in the equipment room to reach the fiber connection 

module in the equipment rack and to make a 10 m service loop.

2. Run the sensor cable to the designated start point of the detecting cable.

3. If the site plan calls for a splice at the designated start point, ensure that there is enough cable 
to reach the splice enclosure on the fence, plus enough to make a 10 m service loop, and if 
required, a 13 m isolation loop (optional) then cut the cable.

OR

3. If the site plan calls for a continuous run of cable at the designated start point, leave enough 
cable to make a 13 m isolation loop (optional) and continue to deploy the sensor cable around 
the perimeter.

Figure 57 Solid wall conduit
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4. At each point in the installation where extra cable is required, lay out a sufficient amount of 
cable in a figure 8 pattern to cover the feature. If you are pulling the cable around the 
perimeter, you must pull back a sufficient amount of cable after the cable is dispensed to cover 
the cable length requirement for each feature.

5. Once you have reached the end of the cable reel, leave enough cable to make a 10 m service 
loop for the splice (or for fiber termination).

6. If the installation extends past the end of this cable reel, leave enough cable to make a 10 m 
service loop for the splice, and continue deploying the sensor cable.

Attaching the sensor cable to the fence

FiberPatrol sensor cable is attached to the fence fabric with stainless steel cable ties. Figure 58 is 
an overview of the recommended cable attachment procedure.

• Install the sensor cable on the secure side of the fence (the side opposite the threat).

• Keep the sensor cable straight and taut while attaching it to the fence fabric.

• Attach the cable to the fence fabric at the junction of two fence wires. 

• The recommended spacing between cable ties is 50 cm (20 in.). 

• Attach the sensor cable at both sides of each fence post approximately 25 cm (10 in.) away 
from the post.

1. Beginning at the start point post, attach the sensor cable to the fence at the junction of two 
fence wires at the specified height above ground (point a).

2. Hold the cable straight and level just past the second post and attach it to the fence at the 
junction of two fence wires app. 25 cm away from the second post (point b).

3. Attach the sensor cable at the junction of two fence wires app. 50 cm past point b (point c).

4. Attach the sensor cable at the junction of two fence wires app. 25 cm before the second post 
(point d).

5. Attach the sensor cable at 50 cm intervals on the first fence panel (points e, f, g).

6. Hold the cable straight and level just past the third post and attach it to the fence at the 
junction of two fence wires app. 25 cm away from the third post (point h).

7. Attach the sensor cable at the junction of two fence wires app. 50 cm past point h (point i).

Figure 58 Cable installation procedure
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8. Attach the sensor cable at the junction of two fence wires app. 25 cm before the third post 
(point j).

9. Attach the sensor cable at 50 cm intervals on the second fence panel (points k, l).

10. Proceed along the perimeter, attaching the cable to the fence one panel at a time.

Attaching the sensor cable at protected gates

Before attaching the sensor cable to a gate, ensure that there is a sufficient amount of sensor 
cable laid out to:

• cover the gate

• form the sensitivity loops

• make a 10 m service loop on hinged side(s) of gate

• make 13 m isolation loops (optional)

1. Refer to the site plan and lay out a sufficient amount of sensor cable in a figure 8 pattern.

2. Loosely attach the sensor cable to the post on which the gate is hinged. Attach the sensor 
cable to the gate at ¼ the fence height, 30 cm away from the outside edge, and ¾ of the fence 
height.

3. Hold the conduit against the fence post and on the conduit, mark the positions of any 
hardware on the fence post that will require notches in the conduit.

4. Make any required notches in the conduit.

5. Place the notched half of the conduit under the cable against the fence post and hold it in 
place.

6. Press-fit the sensor cable into the split loom so the split loom extends 7.5 cm (3 in.) beyond 
the top and bottom of the split conduit.

7. Fit the other half of the conduit over the split loom and cable and secure the conduit to the 
fence post with the supplied gear clamps. Ensure the split loom covers the sensor cable, and 
protects it from chafing against the top and bottom edges of the conduit.

8. Form a sensitivity loop and attach the sensor cable to the fence panel leading up to the gate. 

9. Form a sensitivity loop and attach the sensor cable to the fence panel leading away from the 
gate.

Figure 59 Cable installation on gates

service loop

attach the cable securely on the gate panel 
and the fence fabric leading up to the gate

do not attach the sensor cable in the sections
that must rotate when the gate is in use

cut notches in the split tube if necessary to accommodate
post fittings so it sits flush against the fence post
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Masonry walls and buildings
To install sensor cable on masonry, custom P-clamps are used to secure the cable so it extends 
about 5/8 in. past the edge of the wall and 5/8 in. above the height of the wall. The P-clamps are 
attached to the masonry surface every 50 cm (20 in.). Adjust the spacing of the P-clamps at any 
changes in direction (horizontal or vertical) to ensure the minimum bend radius of the sensor cable 
is not violated. Follow standard masonry fastening procedures approved for light to medium duty 
applications.

The P-clamps are 2.5 in. galvanized steel, and are designed to be anchored with a single screw. 
Self-tapping 3/16 in. by 1-1/4 in. concrete screws, such as Tapcon® screws with slotted hex 
washer heads are recommended. The required mounting holes are 5/32 in. diameter and 1 1/2 in. 
deep and are centered 1.5 in. from the edge of the surface. The cable loop in the P-clamp is vinyl-
coated and sized to grip a standard sensor cable snugly once the clamp is closed.

Begin by drilling 5/32 in. mounting holes that are centered 1.5 in. from the edge of the surface. 
Each hole should be 1 1/2 in. deep. Tapcon 3/16 in. X 1 1/4 in. hex washer anchors are 
recommended for fastening the P-clamps to the surface. 

Figure 60 Masonry surface mounting hole dimensions

Figure 61 Masonry surface P-clamp spacing
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1. Measure and mark the mounting hole locations on the surface.

2. Using a 5/32 carbide-tipped bit, drill the mounting holes 1 1/2 in. deep.

3. Once the holes are drilled, use compressed air to blow out any residue.

4. Fit a P-clamp over the sensor cable and pinch the ends together with your fingers so the 2 
holes line up.

5. Use lineman pliers to squeeze the bracket together at the sensor cable end of the clamp.

6. Fit a 3/16 in. X 1 1/4 in. Tapcon screw through the 2 holes and fasten the P-clamp to the 
mounting surface with a power driver.

Do not over-tighten to avoid stripping or shearing the screws. The sensor cable should be 
manually tensioned as it is being clamped and fastened to keep it straight and taut. Installed 
sensor cable must not sag or touch the surface. 

Buried cable installation
There are ten steps required to complete a FiberPatrol buried cable installation:

1. Create a detailed site plan and obtain the required components.

2. Deploy the sensor cable according to the site plan. 

3. Make any required field splices (excluding the end module and start module splices). 

4. Use an OTDR to measure the loss in each spliced fiber from both ends of the sensor cable 
before making the splices to the end module and start module.

5. Install and connect the control room equipment.

6. Make the fusion splices for the sensor unit and end module.

7. Set up and configure the system software.

8. Bury the sensor cable.

9. Calibrate the system.

10. Test the system to ensure it meets the site’s detection requirements.

Laser light safety

Optical fiber safety

Note Mark the desired hole depth on the bit with a piece of colored tape.

WARNING

FiberPatrol operates with Class 1 laser light levels.
Do not look directly into the end of a fiber connector.
Ensure that the fiber optic light source is off, before using a scope to 
check a fiber optic connector.

WARNING

Use care when working with exposed optical fibers. The bare fibers are 
125 microns in diameter and can easily penetrate skin.
Always wear safety glasses when working with optical fibers.
Always dispose of fibers in a sealed and labeled container that is 
specifically designed to contain fiber optic waste.
NEVER dispose of bare fibers in a standard waste receptacle.
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Fiber optic cable handling

The following are typical performance specifications for armored FiberPatrol fiber optic sensor 
cable used in buried pipeline applications:

• fiber count: 24

• fiber type: single-mode

• fiber wavelength: 1550 nm

• minimum allowable bend radius (dynamic): 30 cm (12 in.)

• minimum allowable bend radius (static): 15 cm (6 in.)

• minimum allowable bend radius (single fiber): 32 mm (1.25 in.)

• maximum allowable tensile rating during installation (short term): 2700 N (600 lbf)

• maximum allowable tensile rating installed (long term): 800 N (180 lbf)

• temperature ratings (storage/operation): -40 to 70ºC (-40 to 158º F)

• temperature ratings (installation): -30 to 70ºC (-22 to 158º F)

• outside diameter (nominal): 15 mm (0.59 in.)

• cable weight: 190 kg/km (128 lb/1,000 ft.)

Cable loss limits (maximum attenuation)

After being installed, each sensor fiber must be tested using an OTDR operating at 1550 nm. 
Measure the loss from both ends of the cable, and use the higher of the two readings.

• The maximum allowable total span loss including cable loss and splice losses for the 
FP115040U/H when used for perimeter intrusion detection applications is 9.6 dB.

• The maximum allowable total span loss including cable loss and splice losses for the
FP115040U/H when used for pipeline or data conduit TPI applications is 12 dB.

• maximum individual event loss limit: 0.3 dB 

Cable handling recommendations

• Bend management systems must be used to restrict cable bend during installation so that the 
minimum bend radius is not violated. (Cable pulleys of a suitable diameter must be used at 
points where the cable changes directions during installation.)

• Fused swivels and tension controlled hauling winches must be used to ensure the cable is 
installed at a tension that does not exceed the specified limits.

• Cable spools must be positioned to limit cable bending and minimize the angle of cable pay-off 
during unwinding/hauling.

• Cable spools must be held firmly in the pay-off stands to ensure smooth rotation and prevent 
any vibration which can damage the cable and the drum.

Note Measure the loss from both ends of each fiber before splicing the fibers to 
the fiber connection module and end module, and before burying the 
sensor cable.

Note Fusion splice performance typically results in a loss of between 0.01 and 
0.03 dB.
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Illustrated installation recommendations 

Pipeline TPI

For third party interference detection the recommended installation places the fiber optic sensor 
cable at least 50 cm (20 in.) below the surface and centered directly above the pipeline. The 
sensor cable should also be a minimum of 50 cm (20 in.) away from the pipe. However, if there is 
an existing fiber optic cable beside the pipe in the trench, or if circumstances make it difficult, or 
impractical, to install the fiber optic cable above the pipeline, the cable can be laid in the trench 
beside the pipe. The burial depths for different types of pipelines vary, and depend on a number of 
factors such as the geographic location and the installation environment. Positioning the sensor 
cable at least 50 cm away from the pipeline provides excellent detection of digging from above. 
The maximum length for third party interference is 50 km/side (100 km total).  

Intrusion detection (vehicles and human targets)

For intrusion detection the recommended installation places the fiber optic sensor cable 30 to 
45 cm (12 to 18 in.) below the ground’s surface. For loose soil types that do not conduct vibrations 
well, like sandy loam, a shallow burial depth is recommended. For denser more compacted soils 
that do conduct vibrations well, like clay, the sensor cable should be buried up to 45 cm below the 
surface. The maximum length for intrusion detection is 40 km/side (80 km total).  

Figure 62: Sensor cable burial for third party interference detection

Figure 63: Sensor cable burial for intrusion detection
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Intrusion detection (tunneling activity)

For detection of tunneling activity the recommended installation places the fiber optic sensor cable 
a minimum of 2 m (6.5 ft.) below the ground’s surface. The increased burial depth is required to 
prevent incidental vibrations originating above ground from causing nuisance alarms. FiberPatrol 
can detect digging and tunneling activity up to 20 m (66 ft.) away from the sensor cable. 
FiberPatrol can also detect the movement of people and vehicles inside an existing tunnel. The 
burial depth of the sensor cable should be increased (made deeper) if there is the potential for a 
tunnel that is more than 20 m deep. The maximum length for tunnel detection is 40 km/side (80 km 
total).  

Installation details  

The following recommendations and requirements apply to FiberPatrol buried sensor applications.

• burial depth (third party interference): the recommended burial depth for the sensor cable is 
50 cm (20 in.) below the ground and 50 cm above the pipeline ± 7.5 cm (3 in.) (see Figure 62:)

• burial depth (above ground intrusion detection): the recommended burial depth for the sensor 
cable is from 30 to 45 cm (12 to 18 in.) (see Figure 63:)

• burial depth (tunneling activity): the recommended burial depth for the sensor cable is a 
minimum 2 m (6.5 ft.) (see Figure 64:)

• recommended clearance: minimum 6 m (20 ft.) of clearance on each side of the sensor cable 
to prevent vibrations created by an object from disturbing the cable; total clear area centered 
over cable 12 m (40 ft.) (see Figure 65:) (e.g., fences, sign posts, utility poles, trees, bushes 
and vegetation over 30 cm high, etc.) 

Figure 64: Sensor cable burial for tunneling detection

Note Consult the local regulations and the pipeline specification for any 
installation requirements concerning the location of buried cable for 
communication and detection purposes.

Note The maximum length for sensor 1 or sensor 2 is equal to the total length 
specification of the particular software activation license. This includes both 
lead cable in excess of 500 m and detecting sensor cable. You cannot 
increase the length of one of the sensors beyond the maximum by reducing 
the length of the other sensor; e.g., the maximum length of each sensor in 
the FP115040 is 40 km (50 km for TPI) the maximum combined length of 
both sensors is 80 km (100 km for TPI).
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• smallest allowable bend radius, armored sensor cable: during installation (dynamic) 30 cm 
(12 in.); installed (static) 15 cm (6 in.) (see Figure 66:) 

• sensor cable tensile rating during installation: 2700 N (600 lbf)

• sensor cable splices: FiberPatrol sensor cable fibers require high quality fusion splices

• the fusion splices are contained inside splice trays 

Note Vegetation within the 12 m (40 ft.) clearance area should be kept below a 
height of 30 cm (12 in.).

Figure 65: Minimum separation distances from obstacles

Figure 66: Smallest allowable bend radius (sensor cable)

6 m (20 ft.) 6 m (20 ft.)

sensor cable

min. clear area min. clear area

NOTE:

ground surface

2 m (6.6 ft.) typical

The clear area must be kept free of running water.

30 cm 

static bend radius

(12 in.)

15 cm

(after installation)

dynamic bend radius
(during installation)

 (6 in.)



Buried cable installation

Page 62 FiberPatrol FP1150 Product Guide

• for outdoor splices the splice trays are housed in weatherproof enclosures 

• for outdoor splices the weatherproof enclosures are protected inside buried vaults 
(see Figure 67: and Figure 68:)   

Buried vault installation details
• burial depth: flush with ground surface 51 cm (20 in.) dig a deeper pit for below ground vault

(i.e., the bottom of the pit can be at the same depth as the sensor cable)

• pit dimensions (nominal): 51 cm (20 in.) deep X 76 cm (30 in.) wide X 107 cm (42 in.) long

• gravel layer: to depth of cable entry points 13 cm (5 in.) nominal (plus 5 cm (2 in.) gravel layer 
on the bottom of the pit)

• sand layer: pour sand over cable, splice enclosure and gravel layer to completely fill the vault

• cable entry points: drill holes for cable entry; 2 cm (0.8 in.) recommended hole size

Figure 67: Ground level buried vault closed and open

Figure 68: Buried vault dimensions

Note Conduct the OTDR cable testing BEFORE filling the vault with sand.
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Installing sensor cable in a buried vault

• for below ground termination of fiber optic cable (buried end module): 10 m (33 ft.) service loop

• for fiber splices: 10 m (33 ft.) service loop for each cable entering the splice enclosure

• ensure that the minimum bend radius (dynamic and static) is not exceeded during or after 
installation

Splice service loops
Service loops provide the extra sensor cable that is required when making fusion splices. A 10 m 
(33 ft.) service loop is required for each section of sensor cable at all splice locations. A 10 m 
service loop is comprised of 5 loops of cable with a 60 cm (2 ft.) diameter. Underground service 
loops are installed inside buried vaults along with the splice enclosures. In the equipment room, 
the service loops are usually attached to the back of the equipment rack. 

FiberPatrol cable installation (pipeline TPI)
1. Ensure that there is enough sensor cable at the head end location to reach the fiber 

connection module in the equipment rack and to create a 10 m service loop inside the 
equipment room.

2. Backfill the trench over the pipeline to a level depth of 50 cm (20 in.) above the pipe.

3. Run the sensor 1 sensor cable to the designated start point of the detecting cable on the 
pipeline.

4. If the site plan calls for a splice at the designated start point, leave enough sensor cable to 
create a 10 m service loop, and then continue deploying the cable.

5. Lay the sensor cable so that it is centered directly above the pipeline.

6. Continue to lay out the cable until reaching the designated splice point or endpoint.

Figure 69: Buried sensor cable splice recommendations
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7. Once you have reached the end of the cable reel, leave enough cable to create a 10 m service 
loop for a splice (or for fiber termination).

8. Return to the start point of detecting cable and repeat the installation procedure for the sensor 
2 cable in the opposite direction along the pipeline.

FiberPatrol cable installation (intrusion detection)
1. Ensure that there is enough sensor cable at the head-end location to reach the fiber 

connection module in the equipment rack and to create a 10 m service loop inside the 
equipment room.

2. Dig the trench along the designated cable path at the specified burial depth (30 to 45 cm; 
12 to 18 in.). Keep the burial depth consistent (± 7.5 cm; ± 3 in.).

3. Run the sensor 1 sensor cable to the designated start point of the detecting cable.

4. If the site plan calls for a splice at the designated start point, leave enough sensor cable to 
create a 10 m service loop, and then continue deploying the cable.

5. Lay the sensor cable so that it is centered in the trench.

6. Continue to lay out the cable until reaching the designated S1 endpoint (or a fiber drop point).

7. Once you have reached the end of the cable reel, leave enough cable to create a 10 m service 
loop for a splice (or for fiber termination).

8. Return to the start point of detecting cable and repeat the installation procedure for the sensor 
2 cable in the opposite direction along the perimeter.

FiberPatrol cable installation (tunneling activity detection)
1. Ensure that there is enough sensor cable at the head-end location to reach the fiber 

connection module in the equipment rack and to create a 10 m service loop inside the 
equipment room.

2. Dig the trench along the designated cable path at the specified burial depth (minimum 2 m). 
Keep the burial depth consistent.

3. Run the sensor 1 sensor cable to the designated start point of the detecting cable.

4. If the site plan calls for a splice at the designated start point, leave enough sensor cable to 
create a 10 m service loop, and then continue deploying the cable.

5. Lay the sensor cable so that it is centered in the trench.

6. Continue to lay out the cable until reaching the designated S1 endpoint (or a fiber drop point).

7. Once you have reached the end of the cable reel, leave enough cable to create a 10 m service 
loop for a splice (or for fiber termination).

8. Return to the start point of detecting cable and repeat the installation procedure for the sensor 
2 cable in the opposite direction along the perimeter.

Note Conduct the OTDR cable testing BEFORE burying the sensor cable.

Note Conduct the OTDR cable testing BEFORE burying the sensor cable.

Note Conduct the OTDR cable testing BEFORE burying the sensor cable.

Note Refer to Sensor cable verification and test on page 65 and Control 
equipment installation on page 65 to complete the installation.
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Sensor cable verification and test
Before making the splices to the connection module in the equipment room and the end modules 
do a continuity check of all spliced fibers and OTDR test the two sensor fibers (S1 and S2).

Continuity test

Use a visual fault locater (VFL) to verify continuity in S1 an S2, as well as any dark fibers that were 
field spliced during the cable installation.

OTDR test

Before splicing the sensor fibers in the connection module and the end modules test the two 
sensor fibers from both ends of the cable with an OTDR at the following settings:

wave length = 1550 nm
pulse width = 100 ns
average time = 2 min.
splice loss  0.03 dB (typical)
range  cable length

The maximum allowable total span loss including cable loss and splice losses for the 
FP115005U/H is 4.8 dB.

The maximum allowable total span loss including cable loss and splice losses for the 
FP115040U/H when used for perimeter intrusion detection applications is 9.6 dB.

The maximum allowable total span loss including cable loss and splice losses for the
FP115040U/H when used for pipeline or data conduit TPI applications is 12 dB.

The maximum loss for a single event is 0.3 dB.

Control equipment installation
The FiberPatrol electronic control components are designed to be installed in an EIA 19 in. 
equipment rack. The rack requires a mounting depth of 20 in. (51 cm) plus a minimum 2 in. (5 cm) 
of front space between the equipment and the rack doors and at least 6 in. (15 cm) of rear space 
for cables and ventilation. The overall depth of the rack must be a minimum of 28 in. (71 cm). Both 
the front and back of the equipment rack must be accessible for a technician to make the cable 
connections and to access power switches and reset buttons. The FiberPatrol electronic control 
components require 6 contiguous rack units (RU) beginning at least 12 in. (30 cm) above the floor. 
The sensor unit occupies 4 RU, the fiber connection module 1 RU, and the optional rack-mount 
keyboard/monitor/mouse 1 RU. 

The FiberPatrol sensor unit operates on 100 to 240 VAC 50/60 Hz and consumes 200 W 
maximum. The sensor unit requires 2 independent AC receptacles. An additional AC receptacle is 
required if the optional rack-mount keyboard/monitor/mouse is being used at the site.   

CAUTION Critical losses in the sensor cable discovered by OTDR testing must be 
investigated and rectified before making the connection module and end 
module splices.

Note It is strongly recommended that the FiberPatrol control equipment 
components be powered through a UPS system.
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FiberPatrol splices

FiberPatrol sensor cable requires high quality fusion splices in the equipment room, as well as at 
any outdoor field splice locations including fiber termination at end modules. All splices are made 
in a splice tray which is installed either in the 1 RU fiber connection module for equipment room 
splices, or in an outdoor rated splice enclosure for field splices. All fiber splices must be tested and 
verified with an OTDR (typical results range from 0.01 to 0.03 dB loss per splice; maximum 
allowable loss per event is 0.3 dB). Figure 6 shows a splice tray and a dual end module. The 
equipment room and end module fiber splices are identified in the following table.

Figure 71 FiberPatrol equipment room block diagram

CAUTION The FiberPatrol sensor unit and patch cables include protective dust caps 
on the connectors. Leave the dust caps in place until you make the 
connections. Do not touch the ends of the fiber connectors or allow the 
ends of the fiber connectors to touch anything. To make the connection, 
remove the dust cap, thoroughly clean the connector ends, and then 
gently insert the FC/APC connector and tighten until finger-tight.

Sensor cable fiber Fiber connection module 
(label)

Field installed end 
module (label)

S1 - blue (cable beginning) 5 - - -

S2 - orange (cable beginning) 6 - - -

S1 - blue (cable end) 7 or 8 7 or 8

S2 - orange (cable end) 7 or 8 7 or 8

Refer to the site plan for details on additional fibers which may require splicing.

Sensor cable fiber splicing connections
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FiberPatrol FP1150 sensor unit

fiber connection module

security
management

system

EIA 19 in. equipment rackmin. 30 cm (1 ft.) above floor
(20 in. mounting depth, 2 in. frontal
clearance, 6 in. rear space clearance)

1 RU
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(optional)
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4 Maintenance

Recommended maintenance
The FiberPatrol system requires minimal maintenance to ensure proper operation. However, 
setting up and following a maintenance schedule based on your site-specific requirements can 
ensure proper detection performance, prevent nuisance alarms and extend the operational lifetime 
of the system. The frequency at which the maintenance should be scheduled depends on your 
security requirements and on the installation environment. This section includes the recommended 
maintenance activities along with suggested intervals.

1. Perform a visual inspection of the installation (quarterly). Check for the following: 

• fence condition - ensure the fence is in good condition and that there are no loose panels, 
loose fittings or metal bits that can move with the wind and cause nuisance alarms (a 
shake test in which you grip the fence fabric in the middle of a panel and shake it back and 
forth with an increasing amount of force can help identify any loose pieces)

• for buried cable applications, check the cable path for washouts or depressions; and keep 
vegetation above the cable trimmed to 30 cm (if possible)

• gates - ensure that all gate hardware is tight and secure and cannot move in the wind

• there are no washouts or depressions under the fence

• vegetation beside and above the fence is cut back and cannot make contact with the 
fence (the frequency at which vegetation must be cut back depends on the local growing 
conditions)

• the sensor cable is fastened firmly against the fence fabric and the cable ties are holding 
the cable securely in place

• there is no loose sensor cable

• service loops and isolation loops are securely attached to the fence fabric

• splice enclosures are properly mounted and secured according to the installation 
instructions

2. Physically test the system (once per week at randomly selected locations; once per year at all 
locations). High security sites should increase the frequency of testing (e.g., daily at randomly 
selected locations; twice per year at all locations).

Note FiberPatrol strongly recommends that the fence be kept clear of 
accumulating snow and ice. Both snow and ice have a dampening effect 
on the transmission of vibrations and will lead to a reduced probability of 
detection. Significant snow accumulation can also provide a bridging aid 
for defeating the sensor. 
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• use a hard, blunt tool (e.g., a screwdriver) to simulate a series of cut intrusions by tapping 
the fence and verify that alarms are declared and accurately located each time

• climb on the fence at several locations and verify that alarms are declared and accurately 
located each time

• for buried cable, use a hard, blunt object (e.g., a hand tamper) to thump the ground’s 
surface above the sensor cable and verify that alarms are declared and accurately located 
each time

3. Check the system status on the FiberPatrol Information Display System (IDS).

Monitor the System Status on the Status panel (daily):

• Initializing (steady) indicates the system is starting up

• Armed (steady) indicates the system is operating properly

• Warning (flashing) system operation is compromised, but detection is operational

• Disarmed (flashing) indicates system failure

• Cable Cut (steady) indicates that the sensor cable is cut or damaged and some or all 
detection capability is lost

• The supervisor should use the Test Alarm, Simulate Cut and Simulate Status functions 
regularly, to verify the system’s functionality.

• The supervisor should review the Log Files on a regular basis to verify system operation.

• The supervisor should review the Signal sub-panel on a regular basis to check the Signal 
Display.

4. Check the electronic equipment and connections (quarterly).
Verify that all system connections are properly seated and secure. Ensure that all cables are 
properly organized and are not exposed to potential damage. Check the LEDs on the RAID 
hard drives (blue Led lit = ON). Verify that there is adequate clearance for ventilation and clean 
the processor’s filters, if required (clean the filters in warm water and ensure that they are 
completely dry before replacing them in the filter trays on the front doors).

5. If a reflection is found at the start of the sensor cable you must clean both the external 
connectors (from connection module) and the internal connectors (inside SU).
Disconnect the S1 and S2 external connectors from the back of the SU. 
Clean the external connectors with a lint free cloth and isopropyl alcohol and fit the dust caps 
onto the connectors. 
Loosen the thumb screws on the SU fiber optic connection panel and carefully remove the 
panel from the SU.
Disconnect the S1 and S2 internal connectors from the SU fiber optic connection panel. 
Clean the internal connectors with a lint free cloth and isopropyl alcohol and reconnect the 
internal connectors.
Reinstall the fiber optic connection panel and reconnect the external connectors.
Verify that the reflection at the start of the sensor cable has been removed.

6. Battery test (once per year)
If your FiberPatrol system includes battery back-up, disconnect the power to the components 
and allow the system to run on battery power until the battery runs down and the system shuts 
down. Note the duration of the battery run-time, and replace the battery when the run-time no 
longer meets the site specification.

Note Contact maintenance promptly if the System Status field displays Cable 
Cut, Warning, or Disarmed. 

CAUTION DO NOT disconnect the fiber optic cables after they are installed (S1/S2). 
Any dust or contamination will compromise system operation.
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System Diagnostics 
The FiberPatrol software monitors the FiberPatrol system for any operational issues or component 
malfunctions. System self-diagnostics can detect and report the following conditions:

• Sensor cable or lead cable damage

• Loss of optical connections to sensor unit

• Failure of certain optical or electronic components in sensor unit

• Malfunction of data acquisition card in sensor unit

The following conditions cannot be self-diagnosed

• Sensor unit malfunction or crash

• Operating system and software driver errors

• FiberPatrol software interface crash

Some conditions resulting from incorrect or improper system installation, configuration, or 
calibration may also not be detectable by system self-diagnostics. To view the system Status panel 
select Service > Status. The following table summarizes the System Checkpoints.  

Figure 72: FiberPatrol Status dialog
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System Status Reporting 
When FiberPatrol software detects an error condition, it alerts local and remote operators by 
reporting the corresponding System Status and generating Head End alarms. The System Status 
indicator in the lower left corner of the FiberPatrol software interface can show four general states: 

• Armed - normal operation

• Cable Cut - sensor cable cut

• Warning - non-critical failure, intrusion detection still possible

• Disarmed - critical failure that disables the system (no detection)

Head End alarms are generated and reported when the general system status changes to 
Disarmed. Head End alarms are treated by the FiberPatrol system the same way intrusion alarms 
are. By default, they are reported with a location of -1000 and zone label HeadEnd, and are 
displayed on the map at the point where the system’s electronic equipment is located. Head End 
alarms can be cleared. However, clearing a Head End alarm does not fix the underlying problem. 
Even if the current system status is Armed, recent Head End alarms may indicate a recurrent 
system problem that needs to be addressed.

Remote Systems

For a system located at a remote site and monitored via a network, the following could be signs of 
a system malfunction:

• Remote connection is dropped or was not established

• Unit status alarm is received from the remote system

• Unit Disarmed status is reported

W/D Indication

W/D S1 and S2

Pr Hard drive RAID 1 intact
Redundant power supply intact

Tx Communication port to laser open
Communication with laser valid
Communication port to transmit amplifier open
Communication with transmit amplifier valid

Rx Communication ports to receiver amplifiers open
Communication to receiver amplifiers valid

ADC Acquisition card present
Acquired data valid

Env Transmit amplifier temperature in range

S1 Net signal for sensor 1 in range

S2 Net signal for sensor 2 in range

Com Communication port to laser open
Communication ports to amplifiers open

Pow S1 AND S2 (split sensor layout)
S1 OR S2 (redundant sensor layout)
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If a remote connection is active, using a remote desktop application to connect to the FiberPatrol 
sensor unit can be an effective way to troubleshoot the system.

If it is impossible to establish a remote connection to any of the equipment at the remote site, then 
it is likely to be a network issue, which should be referred to IT personnel. 

If other equipment at the site is still communicating, but the FiberPatrol system is not, then it could 
be a FiberPatrol system failure, requiring a site visit for further diagnostics.

Local Systems

Locally, the state of the system can be quickly assessed by checking the sensor unit Alarms 
screen. The following are indications of a system malfunction:

• Blank, blue, or frozen screen

• Windows error messages

Any issues detected by self-diagnostics would be indicated in the System Status field: 

• Warning

• Disarmed

• Cable Cut

• Head End alarms (current or recent)

If the system appears to be armed and operational, the following signs may indicate improper 
system settings or calibration:

• Failure to generate sensor alarms

• Incorrect sensor alarm locations

Common Scenarios

Power surges and outages can temporarily disable security systems. They can also cause serious 
equipment problems, especially if occurring often. FiberPatrol systems are configured to 
automatically recover from a power outage. However, every time electronic and computer 
equipment is hard-booted, there is the potential of an operating system or file structure corruption, 
or hardware damage. Unstable line power is particularly dangerous as it may cause a rapid 
succession of reboots that may leave equipment damaged or in an error state requiring a manual 
reboot. A properly configured uninterruptable power supply (UPS) is recommended for use with 
FiberPatrol head end equipment. Soft shutdown and remote reboot functionalities are also 
strongly recommended. 

Sensor unit crashes are rare occurrences for properly installed and configured equipment. Often 
they are caused by external factors such as elevated operating temperature, unstable line power, 
or improper handling of back panel cabling. Sensor unit hardware and software configuration are 
stable under normal operating conditions. Intermittent or fatal crashes can be caused by a 
hardware malfunction, such as a hard drive failure. Hardware failure is often a consequence of 
abnormal operating conditions. 

Unplugged, loose, or mishandled cables are a common cause of system downtime. Fiber-optic 
jumpers, in particular, can be easily damaged when handled carelessly. Even power cables can be 
incorrectly installed, or partially pulled out leaving them half-plugged and creating a spark gap. 

Dirty single-mode fiber optic connectors are often to blame for optical losses in the system. Fiber 
optic jumpers should not be disconnected, unless absolutely necessary. Unplugged fiber 
connectors must be covered immediately with caps. The fiber connectors should always be 
inspected and properly cleaned before they are plugged-in.
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Swapped cables can cause error states that are difficult to diagnose. FiberPatrol head end 
equipment uses two fiber optic jumpers to connect the system lead cable to the sensor unit. Refer 
to the Site planning and installation guide for FiberPatrol Head End connection details. 

Installation, configuration, or calibration issues generally become evident when the system is first 
armed and tested. Any problems must be rectified before commissioning the system. In addition, 
care must be taken to avoid any installation, configuration, or calibration issues following system 
repairs, reconfigurations, or upgrades. Accidents, such as falling trees and tree limbs and 
installation problems at gate areas are the leading causes of outdoor sensor cable damage.

Troubleshooting procedures
This section outlines the procedures to follow when checking, or troubleshooting an installed 
FiberPatrol system. The initial steps in addressing a system malfunction are:

• System inspection

• Connections check

• Sensor unit reboot

• Documentation and reporting

Facility and Equipment Access 
Obtain the necessary permissions and means (keys, codes, etc.) to access the facility, the 
equipment room, and the equipment cabinet. 

System Inspection

Note the general conditions in the equipment room and rack enclosure, including:

• Ambient temperature

• Electrical power

• The state of other equipment

• Network and Internet connectivity

Sensor unit hardware check

Inspect the sensor unit and note the following:

• General state (ON/OFF)

• LED states (ON/OFF/Flashing)

• Fan noise

• Beeping sounds

• Other noises

• Other abnormal indications

Sensor unit interface check

Use the rack-mount keyboard, monitor and mouse to access the sensor unit. Document any of the 
following display conditions: 
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• OFF (no video signal)

• ON, but blank

• Blue screen

• Frozen with a BIOS screen

• Frozen with a Windows screen

• Frozen with a FiberPatrol software screen

• BIOS error screen

• Windows error message

FiberPatrol software check

If the sensor unit (computer) is responsive, document any of the following conditions:

• Running or not running

• Frozen or responsive

• System Status (Armed, Cable Cut, Warning, or Disarmed)

• Head End alarms

• Status of System Check Points (Service > Status)

Take a screen-shot of the signal response in the Signal graph on the System panel (requires 
Installer access level). Note any of the following conditions:

• Signal graph is blank

• Signal is a flat line at 0

• Signal line is fuzzy 

• Signal never goes below 0

• Signal never goes above 0

Cable connections check

Visually and manually examine all cables and connections on the back panel of the sensor unit. 
For each connection, verify:

• All connectors are properly seated and fully plugged in 

• Retaining screws are fastened and finger-tight

• All connectors are secure (no wiggle room)

• Both ends of each cable are properly connected

• Cables have no visible damage

• The connector keys are aligned (if not aligned, a connector will protrude more than the others)

• For both fiber optic connections, verify that the connector is not loose or over-tightened (the 
FC/APC connectors should be finger-tightened until snug)

• The fiber optic cables are connected according to the labels

• Fiber optic cables are routed loosely, without excessive bending, kinks, or crush points

• If a reflection is found at the start of the sensor cable you must clean both the external 
connectors (from connection module) and the internal connectors (inside SU).
Disconnect the S1 and S2 external connectors from the back of the SU. 
Clean the external connectors with a lint free cloth and isopropyl alcohol and fit the dust caps 
onto the connectors. 
Loosen the thumb screws on the SU fiber optic connection panel and carefully remove the 
panel from the SU.
Disconnect the S1 and S2 internal connectors from the SU fiber optic connection panel. 
Clean the internal connectors with a lint free cloth and isopropyl alcohol and reconnect the 
internal connectors.
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Reinstall the fiber optic connection panel and reconnect the external connectors.
Verify that the reflection at the start of the sensor cable has been removed.

Monitor any changes in the system status that occur while the connections are being verified.

Sensor unit reboot

Use the following sequence to reboot the sensor unit:

• Shut down the FiberPatrol software via the Exit function (under the System menu)

• Reboot the computer via the Windows Restart function

• Allow the sensor unit to completely initialize

• Allow the FiberPatrol software to completely initialize

Verify the System Status following the sensor unit reboot.

Malfunction Reporting
Save the following items from the sensor unit hard drive to removable media:

• Any relevant screen shots

• The system configuration folder (C:\FiberPatrol\Configuration) 

• The system log folder (C:\FiberPatrol\Log)

Archive these files and attach them to the electronic problem report that is being submitted to the 
Technical Service department. When compiling the report, include the following information:

• How the problem was discovered

• The immediate indications of the problem

• The steps taken to diagnose and solve the problem

• The results of the remedial actions

• Any observation made while following the system check procedures

• The final state of the system

• Any other notes concerning the problem

• The name, company, and contact information of the person providing the technical service

• The facility’s name and address

• The facility’s owner, or manager, or contact person, and their contact information

• The FiberPatrol sensor unit’s software version, the software activation license number, and 
serial number

• The date and time of the service 

• The amount of service time 

CAUTION DO NOT disconnect the fiber optic cables (S1/S2) after they are installed. 
Any dust or contamination will compromise system operation.

Note If the sensor unit (computer) is unresponsive, reboot the sensor unit by 
turning the power switch OFF, waiting at least 30 seconds, and then 
turning the power switch back ON.

Note DO NOT interrupt the computer booting process with another hard 
reboot, or equipment damage may occur. 
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5 Configuration & calibration

Before setting up and calibrating the FiberPatrol sensor, the installer must ensure the following 
steps have been completed:

• all outdoor components are installed and tested

• lead cable, sensor cable, fusion splices, end modules

• OTDR testing of sensor cable completed successfully

• all indoor components are installed and connected

• indoor components powered up and operational (system software running) 

The FiberPatrol sensor unit (SU) uses the Windows 10 pro 64-bit operating system. The SU 
comes with the FiberPatrol Intrusion Detection System (IDS) software and software license 
installed. The FiberPatrol documentation is available on a USB drive.

When the sensor unit is started, it automatically logs onto Windows. The Windows start menu 
includes an application (Launch FiberPatrol.exe) that auto-starts the FiberPatrol IDS software 
when the SU is powered up. Launch FiberPatrol.exe also monitors the sensor unit and will restart 
the FiberPatrol IDS software when it detects that the program is not running. User access to the 
SU is via the keyboard monitor mouse unit in the equipment rack.

When the sensor unit starts, the Launch FiberPatrol popup displays and counts down while the 
FiberPatrol IDS software initializes. To stop the initialization process and prevent the FiberPatrol 
IDS software from starting, select the  in the top corner of the popup during the countdown. To 
restart the FiberPatrol software, select the FiberPatrol icon  on the desktop.

To login to the Windows operating system, use the following credentials 

There are three access levels for the FiberPatrol IDS software, Operator, Supervisor and Installer:

Note Use the FiberPatrol test cable to verify the operation of the sensor unit 
before beginning the Initial configuration procedure.

Computer Name FiberPatrol-xxxx

Windows User Name FiberPatrol

Windows User Password xxxx

Note xxxx = the last four digits of the sensor unit’s serial number.
For added security, change the default Windows login settings. 

Note The default FiberPatrol passwords are provided during the system 
training session. 
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Operator access level

The Operator’s function in the FiberPatrol IDS software is alarm processing. The Operator level 
provides access to the Alarms tab and the Alarm History tab. 

Supervisor access level

The Supervisor’s access level enables password maintenance, detection parameter adjustments, 
alarm zone setup, alarm display, alarm reporting, event simulations and tests.

Installer access level

All initial configuration and setup procedures require the Installer access level. The Installer level 
provides access to the System tab, which is unavailable to the other access levels.

Initial configuration

The FiberPatrol sensor unit is configured for a DHCP network connection. The Windows Live 
Update feature is disabled. The FiberPatrol software and software license are factory installed, 
and the FiberPatrol software will auto-start when the sensor unit is powered up. Once the 
FiberPatrol software is running, it will restart automatically if it is shut down by the user. When 
FiberPatrol is starting, a window displays the time remaining until the software is launched. 

CAUTION The FP1150 configuration settings should be adjusted only by a factory 
trained technician.

Note The configuration setup and calibration procedures in this section 
require the Installer access level. Some of the following procedures 
apply only to one type of FiberPatrol configuration (e.g., split). Verify 
that a procedure applies to your FiberPatrol configuration before 
attempting the procedure (see FiberPatrol configurations for additional 
information on the different configurations).

Figure 73 Launch FiberPatrol window

select the X button to cancel the Launch process
(app. 60 seconds to start-up)
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Once the launch countdown is completed, a Login window displays:

The System Status field will display “Initializing” which will turn to Disarmed, Warning, or Cable Cut 
once the initialization sequence is complete. Ignore the System Status at this time as the 
FiberPatrol system has not been configured.

Safe Start

The FiberPatrol FP1150 series launches into safe start mode during the initialization process. Safe 
start mode prevents potential damage to the photo-detectors that can be caused by incorrect fiber 
installation. If safe start detects a fiber problem the user must login at the Installer level to continue 
the initialization process. 

Figure 74 FiberPatrol login window

Figure 75 FiberPatrol System Status panel during initial startup

Figure 76 FiberPatrol Safe Start

Username (not required)

enter Password

select the level of access

NOTE: contact the system supervisor for login 

(configuration and setup procedures
require the Installer access Level)

            details 

Initializing Warning
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1. A warning will be displayed asking the user to login at the installer level if the software detects 
a possible cross-fiber connection.

After logging in as the Installer, the user will be prompted to disconnect one of the sensor cables 
from the processor (if a cross-connection is suspected).

2. Disconnect 1 of the 2 sensor fibers from the processor.

3. The Installer level user can select Skip Check to initialize in safe mode to prevent possible 
damage.

Figure 77 FiberPatrol Safe Start Warning

Figure 78 Disconnect sensor
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4. If the user continues with the Safe Check by disconnecting a connector and selecting Yes the 
FP1150 software will determine if there is a cross-fiber connection.

5. If no problems are detected with the sensor cable installation a Safe Start Check complete 
message will display. At this time the installer should select Skip SafeStart in the future.

Figure 79 Safe Mode warning

Figure 80 Cross-fiber detected

Figure 81 SafeStart Check Complete
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When first started, the sensor unit loads a default Alarm Screen configuration with a straight line 
perimeter, in which the cable length is based on the license limit.

FiberPatrol sensor cable configurations
Figure 83 illustrates the most common FiberPatrol sensor cable configurations. Refer to 
FiberPatrol configurations on page 19 for additional sensor cable configurations and installation 
details. 

• For Loop configurations, Sensor 1 and Sensor 2 run in opposite directions around the 
perimeter, and back to the start point (see Figure 83). There are two types of Loop 
configurations:

Figure 82 FiberPatrol default Alarm screen (installer access level)

Figure 83 FiberPatrol sensor cable configurations

Alarm processing buttons

Menu selection bar
Sub-panel tabs

Perimeter map display

Alarm data display fields

Status fields

sensor unit icon

0 m point

licensed length to end point

interrupted loop fully closed loop

split
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• The Fully Closed Loop - the two sensors cover the entire perimeter beginning and ending 
at the same location (with or without start point splice). 

• The Interrupted Loop - the two sensors do not fully cover the entire perimeter having 
different start and/or end points, typically to accommodate a building or structure.

• For Split configurations, Sensor 1 and Sensor 2 run in opposite directions from a central point.

System configuration
Select the System tab on the Alarm Screen window. Figure 84 illustrates the System window for 
the FP1150 Series sensor. The numbered points in the illustration correspond to the configuration 
procedure that follows. 

1. Specify the Length Units for this installation. Length Units are Meters or Feet.  

2. Ensure that the Auto Gain Enable box is checked (default is checked).
Once the Auto Gain and Auto Bias indicators change from light green to dark green, wait at 
least 30 seconds to ensure the Auto Gain process is complete, before proceeding with step 3.

3. Once the Net Signal has stabilized between the 2 yellow lines, select the Auto Set button. 
The Auto Set process may take several minutes to complete. While the Auto Set process is 
running the System Status will indicate Initializing. The Auto Set process will match the Set 
Start and Set End with the Actual Start and Actual End for each sensor. The Scales and 
Offsets will be set to default values. The System Status should now be Armed. 

CAUTION The FP1150 configuration settings should be adjusted only by a factory 
trained technician.

Note If you change the Length Units you must restart the software for the 
change to take effect.

Figure 84 FiberPatrol System configuration (installer access level)

Note Wait for the Auto Set (length calibration) process to complete before 
proceeding with the system configuration.

Note If the system is unable to calibrate itself within 5 minutes a popup will 
display indicating that length calibration has failed.
In this case, wait an additional 5 minutes for the system to settle, and 
reselect the Auto Set button.

specify the Length Units

sensor unit icon

0 m point

licensed length to end point
detected cable cut

(installed length of sensor cable)

Set Points and Channel
Status indicators light green

verify Auto Gain Enabled
is checked

select the Auto Set button

dark green Auto Gain
dark green Auto Bias

check the Actual Start
and Actual End of

Sensor 1 and Sensor 2

Troubleshooting button

Global Setup button
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4. Verify that the Actual Ends of Sensor 1 and Sensor 2 are as expected (these values are 
entered automatically by the system and are based on the optical length of the sensor cable). 
Verify that the value of the Sensor Offsets are 0 and the Sensor Scales are 1.

5. Verify that the Channel Status and Set Points indicators display light green, and the Auto Gain 
and Auto Bias indicators display dark green.

6. Select the Global Setup button and enter the installation medium(s) and the maximum lengths 
of S1 and S2.

Global Setup

The Global Setup button on the System tab opens a dialog that simplifies the initial setup of the 
FP1150 sensor.

1. Ensure that the default values for Sensor 1 Max Length and Sensor 2 Max Length are in 
accordance with the expected length capacity of the system and sufficient for the application.

2. Select the installation Medium, e.g. Flexible Fence (Chain Link).

3. The Max Length and Medium parameters automatically set the Pulse Rate, Frame Rate, Low 
Frequency, High Frequency, System End, Set End and if checked, the Environment 
Compensation will also be set.

Troubleshooting dialog 

Figure 85 Global Setup dialog

Figure 86 Troubleshooting dialog
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The Troubleshooting Settings can be used to verify the status of the system hardware (select 
Component Check). It also includes a Skip SafeStart check box to disable the Safe Start on 
subsequent startups. Contact FiberPatrol Technical Support for additional information before using 
the Troubleshooting feature.

Calibration setup 

Optical location identification
Setting up the FiberPatrol system is best done by two people who are in communication during the 
procedure. One person walks around the perimeter, or along the pipeline, and causes alarms to 
mark the features of the site for the system software. The second person monitors the FiberPatrol 
software and records the results of the tests.

The FiberPatrol system can also be setup by one person. In this case, the person synchronizes 
their watch with the time displayed by the FiberPatrol sensor unit, and then walks around the 
perimeter or along the pipeline causing alarms at the locations of the site’s features. As the tests 
are conducted, the person must carefully note the time and location of each test. Once the tests 
are completed, the tester returns to the FiberPatrol SU, reviews the results of the tests in the Alarm 
and Event Logs, and records the appropriate details for future use in the Map Manager software. 

In FiberPatrol installations, the actual length of the sensor cable does not match the length of the 
protected fence, or pipeline. Adjustments must be made for the non-sensing lead cable between 
the equipment room and the perimeter, as well as for site features that require extra sensor cable 
(i.e., gates, bypasses, service loops, sensitivity loops, isolation loops, transition loops). Therefore, 
to ensure location accuracy on the map display, and for alarm reporting, you must conduct 
extensive location calibration testing to match site features and zone boundaries to cable length. 

The recommended method for location calibration is to have one person, the tester, proceed along 
the perimeter doing tests at specified site features and zone boundary locations. The second 
person monitors the tests in the control room, recording the locations of the features and zone 
boundaries. The tester and monitor should maintain communications during this process to ensure 
location accuracy.

Note Verify that the initial configuration was completed.

CAUTION The FP1150 configuration settings should be adjusted only by a factory 
trained technician.

Note The location reported by the FiberPatrol sensor unit is determined by the 
optical distance of the sensor fiber within the cable. This length is similar 
to a measurement made by OTDR equipment. The optical distance can 
be up to 3% greater than the cable length due to the Helix factor of the 
fiber optic cable.

Note The FiberPatrol sensor unit requires a minimum of four identified location 
points along the sensor cable. These points are essential for the accurate 
placement of vertices during the map creation process.

Note Refer to Supervisor’s functions on page 127 for descriptions of 
FiberPatrol menu items.
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Location calibration fences - the tap test   

To mark the features and zone boundaries for the FiberPatrol software, lightly tap the sensor cable 
repeatedly in a rapid sequence (for 5 to 10 seconds) at the same location using a small object 
(e.g., a pencil, pen, screwdriver). Use very little force for each tap (i.e., a light flick of the wrist) and 
keep the amount of force consistent. Conduct a series of three tap tests at the location of each 
feature, or zone boundary, waiting at least 15 seconds between tests. Calculate the average 
location from the three tests at each point and use the average to set the location of the feature in 
the system software. Use the table in Appendix C to record the test results. 

Location calibration buried cable - the tamp test

To mark the features and zone boundaries for the FiberPatrol software, thump the ground directly 
above the sensor cable repeatedly in a rapid sequence (for approximately 10 seconds). Conduct 
each test at one location using a large object with a flat bottom (for striking the ground). A hand 
tamper is recommended for the testing, but the test device can be as simple as a 2 X 4 length of 
lumber. For systems in which the sensor cables are buried well below the surface (e.g., tunneling 
detection) the recommended method for identifying the features requires a small section of 1/2 
inch thick steel plate and a hammer. Place the steel plate on the ground directly above the sensor 
cable and repeatedly strike the plate with a hammer in a rapid sequence (for approximately 10 
seconds). Use a similar amount of force for each impact and conduct a series of three tamp tests 
at each feature/boundary location, waiting at least 15 seconds between tests. Use the average 
location from the three test results to set the location in the system software. Use the Location/
calibration table in appendix C to record the test results.  

Note By convention, Sensor 1 (from the sensor unit or from location 0) goes in 
the direction of increasing zone numbers (i.e., Sensor 1 starts and runs to 
zone 1 then zone 2 then zone 3 etc.).

Note For location calibration and setup, always tap directly on the sensor 
cable, not on the fence fabric.

Note FiberPatrol recommends that the desired locations of the Virtual Zone 
boundaries and site features be indicated on the perimeter fence before 
doing the tap tests (e.g., use tape or string to mark the locations). 
If CCTV camera coverage will provide visual alarm assessment, ensure 
that the fields of view from adjacent cameras provide an 8 m overlap.

Note If the tap tests are being performed and recorded by one person, that 
person’s watch must be synchronized with the time setting of the 
FiberPatrol sensor unit in order to match the alarm times with the alarm 
locations when reviewing the alarms on the Log sub-panel.
If the tap tests are being performed by one person and recorded by 
another, maintain communication between the control room and the 
perimeter to ensure that the alarm times and locations are matched.

Note By convention, Sensor 1 (from the sensor unit or from location 0) goes in 
the direction of increasing zone numbers (i.e., Sensor 1 starts and runs to 
zone 1 then zone 2 then zone 3 etc.).
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Test setup

1. On the Signal sub-panel, set the Disturbance Life and the Event Life to 10 seconds.

2. Select Configure > Alarm Auto Clearing and check the Automatically Clear Alarms and Upon 
Completion checkboxes. Set the time to 10 seconds and apply the changes (see Figure 87). 

Location Calibration for Loop configurations
Calibrating the Set Start for Sensor 1 and the Set End for Sensor 2 (Loop configurations)

Adjust the Detection Settings (see Test setup on page 85).

1. Set the Sensor 1 Offset = 0, Sensor 1 Scale = 1, Sensor 2 Offset = 0, Sensor 2 Scale = 1.

2. Proceed to a point that is 10 m (33 ft.) away from the sensor start point on the Sensor 1 side 
and conduct 3 tap tests at this location. Wait at least 15 seconds between each test.

Note If the tamp tests are being performed and recorded by one person, the 
person’s watch must be synchronized with the time of the processor, to 
match the alarm times with the alarm locations when reviewing the 
alarms in the Event Logging panel or the Alarm Log file.
If the tamp tests are being performed by one person and recorded by 
another, maintain communication between the control room and the 
pipeline to ensure that the alarm times and locations are matched.

Note FiberPatrol recommends that the desired locations of the features and 
Virtual Zone boundaries be indicated on the ground along the cable path 
before doing the tamp tests (e.g., use flags, stakes, or paint to mark the 
boundaries). In addition, either satellite images or detailed drawings of 
the site plan should be available to the tester.

Note FiberPatrol recommends that the tester use a hand held GPS device to 
ensure the accuracy of the location testing. Record the GPS coordinates 
in the Location/calibration table for each test location.

Note Once the location calibration is completed, restore the default settings.

Figure 87 Temporary settings for location calibration

Note For Sensor 1, the FiberPatrol cable between the Sensor Unit and the 
detection start point must be set to non-sensing.
For Sensor 2 the end of the FiberPatrol sensing region must be defined.

select the Automatically Clear Alarms After checkbox,
set the time period to 10 seconds

and select the Upon Completion checkbox

set the disturbance Life and

use the default 
settings

the Event Life to 10 seconds
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3. Calculate the average location of the 3 tests for Sensor 1 (low value). 
For the Sensor 1 start point:
Sensor 1 (low value) - 10 m = Start point of sensing for Sensor 1
Subtract 10 m for the start point service loop.
If there is an optional isolation loop, subtract another 10 m from the result to put the start point 
inside the isolation loop.

• e.g., average location of 3 tap tests for Sensor 1 = 134 m
subtract 10 m to get back to the start point of Sensor 1
(134 m - 10 m = 124 m)
subtract 10 m for the splice point service loop
(124 m - 10 m = 114 m)
in this example (see Figure 88) there is an isolation loop, subtract 10 m for the isolation 
loop
(114 m - 10 m = 104 m)
the Set Start for Sensor 1 = 104 m

4. Set the value of the Set Start for Sensor 1 to the above result (104 m).

5. Save the configuration (select the Configure menu > Save Configuration).

6. Calculate the average location of the 3 tests for Sensor 2 (high value).
For the Sensor 2 end point:
Sensor 2 (high value) + 10 m = end point of sensing for Sensor 2
Add 10 m for the splice point service loop.
Add 10 m to put the end point inside the optional isolation loop.

• e.g., average location of 3 tap tests for Sensor 2 = 2734 m
add 10 m to get to the end point of Sensor 2
(2734 m + 10 m = 2744 m)
add 10 m for the splice point service loop
(2744 m + 10 m = 2754 m)
add 10 m if there is an optional isolation loop
(2754 m + 10 m = 2764 m)
the Set End for Sensor 2 = 2764 m

7. Set the value for Set End Sensor 2 to the above result (2764 m). 

Figure 88 Tap test location - Set Start Sensor 1 (fully closed loop example)

 service 
loop (10 m)isolation

loop (13 m)

 service 
loop (10 m)

start/end point post 10 m (33 ft.)

from start point 
tap cable away 

start point (Sensor 1 =>)start point (<=Sensor 2)
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8. Save the configuration (select the Configure menu > Save Configuration).

Calibrating the Set Start for Sensor 2 and Set End for Sensor 1 (Loop configurations) 

Adjust the Detection Settings (see Test setup on page 85).

1. Verify the Sensor 1 Offset = 0, Sensor 1 Scale = 1, Sensor 2 Offset = 0, Sensor 2 Scale = 1.

2. Proceed to a point that is 10 m (33 ft.) away from the sensor start point on the Sensor 2 side 
and conduct 3 tap tests at this location. Wait at least 15 seconds between each test. 

3. Calculate the average location of the 3 tests for Sensor 2 (low value). 
Calculate the average location of the 3 tests for Sensor 1 (high value).

4. For the Sensor 2 start point:
Sensor 2 (low value) - 10 m = Start point of sensing for Sensor 2 (Set Start 2)
Subtract 10 m for the start point service loop.
Subtract 10 m if there is an optional isolation loop, to put the Sensor 2 start point inside the 
isolation loop.

5. Set the value of the Set Start for Sensor 2 to the above result.

• e.g., average location of 3 tap tests for Sensor 2 = 136 m
subtract 10 m to get back to the start point of Sensor 2
(136 m - 10 m = 126 m)
subtract 10 m for the splice point service loop
(126 m - 10 m = 116 m)
subtract 10 m if there is an optional isolation loop
(116 m - 10 m = 106 m)
the Set Start for Sensor 2 = 106 m

6. Save the configuration (select the Configure menu > Save Configuration).

Figure 89 Entering the Set Start for Sensor 1 and Set End for Sensor 2 (from example above)

Note For Sensor 2, the FiberPatrol cable between the Sensor Unit and the 
start point of the perimeter must be set to non-sensing.
For Sensor 1 the end of the FiberPatrol sensing region must be defined.

Figure 90 Tap test location - Set Start Sensor 2 (fully closed loop example)
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7. For the Sensor 1 end point:
Sensor 1 (high value) + 10 m = End point of sensing for Sensor 1
Add 10 m for the start point service loop.
If there is an optional isolation loop, add 10 m to put the end point inside the isolation loop.

8. Set the value for Set End for Sensor 1 to the above result.

• e.g., average location of 3 tap tests for Sensor 1 = 2738 m
add 10 m to get to the end point of Sensor 1
(2738 m + 10 m = 2748 m)
add 10 m for the start point splice loop
(2748 m + 10 m = 2758 m)
add 10 m if there is an isolation loop
(2758 m + 10 m = 2768 m)
the Set End for Sensor 1 = 2768 m)

9. Save the configuration (select the Configure menu > Save Configuration).

Calibrating the Sensor 2 Offset (Loop configurations)

1. Refer to Calibrating the Set Start for Sensor 1 and the Set End for Sensor 2 (Loop 
configurations) on page 85, to determine the Sensor 1 (low value) and Sensor 2 (high value) 
results from the tap tests.

2. Add the Sensor 1 (low value) and Sensor 2 (high value) results to determine the Sensor 2 
Offset.
e.g., 134 m + 2734 m = 2868 (Sensor 2 Offset)

3. Set the Sensor 2 Offset to the above result.

4. Set the Sensor 2 Scale to -1.

5. Save the configuration (select the Configure menu > Save Configuration).

Calibration setup for Split configurations
For Split configurations, location 0 (the sensor start point) is at the terminated end of Sensor 1 (the 
farthest point on Sensor 1 from the sensor unit). The sensor end point, location n (n = the total 
optical length of the sensor cable) is at the terminated end of Sensor 2 (see Figure 92). Included in 
the total length of the sensor is the amount of lead cable between the sensor unit equipment and 
the protected perimeter. 

Figure 91 Calibrated Sensor Parameters (from examples above)

Set Start values for Sensors 1 & 2

Sensor 2 Offset

Set End values for Sensors 1 & 2
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Calibrating the Sensor Scales and Offsets

Adjust the Detection Settings (see Test setup on page 85).

1. Set the Sensor 1 Scale to -1, and set the Sensor 2 scale to 1.

2. Set the Sensor 1 Offset and the Sensor 2 Offset to the Sensor 1 Set End value.

3. Set the System End to (Sensor 1 Set End value) + (Sensor 2 Set End value).

4. Save the configuration (Select the Configure menu > Save Configuration).

Verify the sensor start point

1. Conduct a series of 3 tests to create 3 alarms at location 0. Location 0 is at the S1 end module 
and represents the start point of detecting cable.

2. Verify that the alarm results are not negative (must be a positive value). 

Location calibration for Split configurations:

To ensure location accuracy on the map display, and for alarm reporting, you must conduct 
location accuracy testing to match site features and zone boundaries to cable length. This location 
accuracy testing is then used for location calibration. Beginning at Location 0, proceed along the 
fence conducting a series of 3 tests to create 3 alarms at each feature and zone boundary.

1. Conduct a series of 3 tests to create 3 alarms at the Sensor 1 end module (location 0) 
(i.e., the detection start point or 0 footmark of detecting cable). Wait at least 15 seconds 
between each test. Record the GPS coordinates and a brief description of the location and the 
start time of each test on the calibration sheet. This will be the start point for the first zone.

2. Proceed along the perimeter to the first feature or to the designated end point of the first zone. 
Conduct a series of 3 tests to create 3 alarms. Wait at least 15 seconds between each test. 
Record the GPS coordinates and a brief description of the location and the start time of each 
test on the calibration sheet.

3. Continue this process until reaching the end of the detecting section of sensor cable for 
Sensor 1 (i.e., at the point where the lead cable runs from the perimeter to the sensor unit). 
This should also be the start point of the detecting sensor cable for Sensor 2. The tests at this 
location may cause alarms on both Sensor 1 and Sensor 2.

4. Conduct as many tests as required between the perimeter and the sensor unit to identify the 
lead cable for Sensor 1 and Sensor 2.

Figure 92 Disturbance location calculation (Split configurations)

Figure 93 Tap test location - Set Start (Split configuration)
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5. Return to the perimeter (beginning of Sensor 2 detecting cable) and continue this process until 
reaching the end of the detecting cable for Sensor 2 (Sensor 2 end module, Location n on 
Sensor 2).

6. Go to the Log sub-panel, and record the locations of the alarms that were generated during 
the tests. Calculate the average location of each set of 3 tests (alarms) for each feature and 
zone boundary location and record the result in the Location/calibration table.

7. Make a copy of the completed Location/calibration table and keep it in a safe place.

Locating the features and zone boundaries
To draw the perimeter line on a site map, and to accurately display the location of alarms, you 
must determine the position of the site’s features and zone boundaries relative to the length of 
sensing sensor cable. To accomplish this, one person goes around the perimeter causing alarms 
at all site features and zone boundaries, while a second person monitors the alarms in the control 
room. Create a series of three disturbances at each feature, and use the average value of the 
three test results for the feature’s location. The tester requires a detailed site plan that clearly 
identifies each feature and zone boundary that must be located for the map display.

1. Make a copy of the Location/calibration table from Appendix c (see Figure 94 for an example 
of the Location/calibration table for fence-mounted).

2. Conduct a series of 3 tests at each site feature and Zone boundary location waiting at least 15 
seconds between tests. Note the time of each test on the Location/calibration table.

3. Go to the Log sub-panel, and record the locations of all the disturbances that were created 
during the tests. Calculate the average location of each series of 3 tests for each feature and 
Zone boundary location and record the result in the Location/calibration table.

4. Make a copy of the completed Location/calibration table and keep it in a safe place.  

Note For the Split configuration, begin testing at location 0 (the S1 end 
module).

Note The FiberPatrol system uses “soft” zone boundaries, which are defined in 
software. The location accuracy of FiberPatrol is 4 m (13 ft.). Therefore, if 
CCTV coverage will be used for alarm assessment there should be an 
overlapping field of view of at least 8 m (26 ft.) at all zone boundaries (see 
Figure 95).
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Figure 94 Example Location/calibration table (fence)

Figure 95 Overlapping CCTV visual assessment
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Zone boundary and site feature identification (fences)
The following figures illustrate the types of features that should be identified and located on the 
FiberPatrol map. To accurately locate and display alarms on a scale site map, the FiberPatrol 
software requires the locations of the start point of sensing cable; the end point of sensing cable; 
all zone boundaries (beginning and end of each zone); service loops; sensitivity loops; isolation 
loops (anywhere that extra cable is attached to the fence) corners and perimeter direction 
changes; sensor cable bypasses; gates; buildings, structures and other obstacles that are located 
on the perimeter. 

At the start point of sensing cable

At the start point of the sensing cable, tap the cable 10 m away from the start point post and 
subtract 20 m to confirm the start point location. 

At splice locations

Tap the cable one fence panel away from the service loop(s) at splice locations.

At sensitivity loops (corners, tension posts, heavy gauge posts)

Tap the cable at the center of the sensitivity loop where it crosses the fence post.

Figure 96 Tap test location - sensor start point

Figure 97 Tap test location - outdoor splices

Figure 98 Tap test location - at corners or heavy gauge posts
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At gate locations

Tap the cable one fence panel away from the isolation loop(s) at gate locations, where the gate will 
be assigned as an independent zone. Measure back to the isolation loop (e.g., 3 m) and add 10 m 
to place the zone boundary inside the isolation loop. (On the far side of the gate subtract the 
distance back to the isolation loop and 10 m to place the zone boundary inside the isolation loop.) 

Tap the cable one fence panel away from the gate location if there are no service loops or isolation 
loops and the gate will be included as part of another zone.

Tap the cable one fence panel away from the service loop(s) at gate locations, where the gate will 
be included as part of a zone.

At bypass locations

Tap the cable two fence panels away from each isolation loop at bypass locations. Record the 
location results for both sides of the obstacle. Measure back to the obstacle and add, or subtract, 
10 m for each isolation loop. Enter the calculated values as the bypass start and end locations.

Figure 99 Tap test location - gate (independent zone)

Figure 100 Tap test location - gate (part of zone, no service/isolation loops)

Figure 101 Tap test location - gate (part of zone)

Figure 102 Tap test location - bypassed obstacles
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At locations of non-linear cable deployment

Tap the cable at the fence posts adjacent to the non-linear deployment. 

At Zone boundary locations

Tap the cable at the location of all soft zone boundaries.

Figure 103 Tap test location - non-linear cable deployment

Figure 104 Tap test location - service loops

Figure 105 Tap test location - zone boundaries
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Zone boundary and site feature identification (buried cable)

To draw the buried cable path on a map, and to accurately display the location of alarms, you must 
determine the position of the site’s features and zone boundaries relative to the length of detecting 
sensor cable. To accomplish this, one person goes along the cable path causing alarms at all site 
features and zone boundaries, while a second person monitors the alarms in the control room. 
Create a series of three alarms at each feature, and use the average value of the three test results 
for the feature’s location. The tester requires a detailed site plan that clearly identifies each feature 
and zone boundary that must be located for the map display. Print as many copies of the 
Calibration Spreadsheet (Appendix c) as are required to calibrate (physically test) each feature 
and zone boundary. Each designated soft zone boundary and feature should be marked on the 
ground above the sensor cable. Photos or drawings of the zone boundaries and feature locations 
should be provided for the tester. In addition, the tester should record the GPS coordinates of the 
zone boundaries and features on the Calibration spreadsheets. 

Beginning at Location 0, (see Figure 92) proceed along the cable path conducting a series of 3 
tamp tests to create 3 alarms at each feature and zone boundary, including:

• the start and end location of each sensor;

• the beginning and end of the lead cable running between the sensor unit and the detection 
start point;

• any significant bend or notable feature along the cable path;

• all splice locations;

• anywhere a surplus of fiber has been spooled;

• any point that is approximately 3 km (1.86 mi.) from another calibration point;

• the beginning and end of each soft zone (all zone boundaries).

1. Conduct a series of 3 tamp tests to create 3 alarms at the Sensor 1 end module (location 0) 
(i.e., the start point or 0 footmark of detecting cable). Wait at least 15 seconds between each 
test. Record the GPS coordinates and a brief description of the location and the start time of 
each test on the calibration sheet. This will be the start point for the first zone.

2. Proceed along the cable path to the first feature or to the designated end point of the first 
zone. Conduct a series of 3 tamp tests to create 3 alarms. Wait at least 15 seconds between 
each test. Record the GPS coordinates and a brief description of the location and the start 
time of each test on the calibration sheet.

3. Continue this process until reaching the end of the detecting section of sensor cable for 
Sensor 1 (i.e., at the point where the lead cable runs from the perimeter to the sensor unit). 
This should also be the start point of the detecting sensor cable for Sensor 2. The tamp tests 
at this location should cause alarms on both Sensor 1 and Sensor 2.

4. Conduct as many tamp tests as required between the perimeter and the sensor unit location to 
identify the lead cable for Sensor 1 and Sensor 2.

5. Return to the beginning of the Sensor 2 detecting cable and continue this process until 
reaching the end of the detecting cable for Sensor 2 (Sensor 2 end module, Location n on 
Sensor 2).

6. Go to the Event Logging sub-panel, and record the locations of the alarms that were 
generated during the tamp tests. Calculate the average location of each set of 3 tamp tests 
(alarms) for each feature and zone boundary location and record the result in the Location/
calibration table.

7. Make a copy of the completed Location/calibration table and keep it in a safe place (see 
Figure 106). 
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Figure 106 Example Location/calibration table (buried cable)
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Creating the site map

The FiberPatrol IDS software can display alarms on a graphical site map created from a satellite 
image. The map is created with the IDS Map Manager software, and is imported into the 
FiberPatrol IDS software. An internet connection is required to download a satellite image of the 
site. Begin by installing the IDS Map Manager software on the configuration computer.

Acquiring the site map image
Map image navigation

• Use the mouse wheel to zoom in and out.
Double left-click to zoom in.
Double right-click to zoom out.

• Left-click, hold and drag to pan across the image.

• Right-click, hold and drag to rotate the image.

1. Start the IDS Map Manager application.

Figure 107 shows the Map Manager start screen. Figure 108 shows the map creation tools and 
Figure 109 shows the map editing toolbar.  

Note Contact Senstar Customer Service for additional information on the IDS 
Map Manager software. 

Note Senstar recommends that the IDS Map Manager software be run on a 
different computer (i.e., not on the FiberPatrol sensor unit). 

Figure 107 IDS Map Manager start screen
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2. To start a New Project select Project > New Project...
The New Project window displays:

3. Enter the Site ID (use any 6 digit number) and Site Name, and then select OK.

Figure 108 Map creation tools

Figure 109 Map editing toolbar

Figure 110 New Project dialog

Hover the mouse cursor over a toolbar item or menu item
and a description of the function will display.

menu bar

tool bar

menus

Undo
Redo

Removes (selected item from map)
Select Area of Interest

Measure the ground distance
Set map orientation to North Up

Go To Location
Extract an Area of Interest

Perimeter Editor
Zone Editor

Perimeter Extender
Perimeter Removal

Split
Merge (N/A)
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4. To select and display a particular location select Map > Go to Location...

5. Enter the GPS coordinates of the site in decimal format (latitude and longitude) and specify 
the Zoom Level (12 - 14) and then select Go.  

6. Save the project file; select Project > Save Project As...
Name the project and save it in a known location (project_name.FPP).  

7. Add a device; select Project > New Device...

• Enter the IP address of the FiberPatrol sensor unit (if you don’t know the sensor unit’s IP 
address, enter 127.0.0.1).

Figure 111 Go to Location dialog

Note If the selected zoom level is too high, there will not be an image 
available (see Figure 112). Reduce the zoom until an image displays.

Note Save the project frequently to prevent data loss from a power outage or 
computer problem.

Figure 112 No image available (reduce the zoom level)

Figure 113 Add New Unit dialog
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• Enter 4122 as the Port number.

• Enter the Device ID (the device ID is 10 followed by the last four digits of the sensor unit’s 
serial number).

• Specify Point-Sensing as the device type.

• Select OK once you have entered the required information.
In the Project tree under Device(s) a device (computer icon) named Sensor - 10xxxx is 
displayed. 

8. Left-click and hold on the device in the Project tree to drag the device to the location of the 
head end equipment on the map.

9. Release the mouse button to drop the computer icon on the map.
Zoom in to verify the sensor unit’s location on the map. 
To reposition the icon, reselect the device on the project tree and drag it to the correct location 
on the map (no undo).

10. Save the project file.

Creating the perimeter
The perimeter line, on which the alarm locations will be displayed, is created in IDS Map Manager. 
In order to accurately display the locations of alarms, you place vertices on the perimeter line and 
define the locations of the vertices in the IDS Map Manager software. 

1. Select and highlight the Sensor in the Project tree. Select the Perimeter Editor tool, and then 
select the Perimeter Extender tool. 
The Zoom level should fully display the site’s protected perimeter.

Figure 114 Placing the device icon on the map

Note A vertex is a point on the virtual perimeter that has a defined location 
(e.g., 10 m for the start point vertex). Place vertices only at positions on 
the map where you have obtained a feature location.
Each vertex will be connected to the next vertex with a straight line. The 
indicated lengths represent the ground distance of the segment and the 
total length of the perimeter. The indicated lengths are different from the 
optical sensor lengths.
A minimum of 4 vertices are required for the map creation process.

left-click & hold
drag & drop at 
the desired location
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2. Start at the beginning of the sensing sensor cable, and add the start point vertex to the map. 

3. Proceed around the perimeter map and use the completed location/calibration table to place a 
vertex at each located feature.  

• To remove a vertex, select the Perimeter Removal tool (hover the cursor over the vertex 
and the hand becomes the removal tool) and left-click the vertex. 
When a vertex is removed, the adjacent vertices are joined by a straight line.

• To add a vertex inside an existing line segment, highlight the segment, and select the Split 
Tool. This creates a vertex in the center of the highlighted segment. Left-click and drag this 
vertex to the desired location.

• To change the location of a vertex left click and release to select the vertex, then left click 
and hold to drag the vertex to the desired location.

4. Select each segment and enter the average optical Start and End locations from the Location/
calibration table.

Figure 115 Drawing the perimeter

Note To end the drawing sequence, select Ctrl + 3. The perimeter line ends at 
the last vertex.

Note Once the perimeter is drawn, a table is created based on the physical 
location of each vertex. The physical (ground) distances must then be 
changed to the optical distances that were obtained during the testing.

Figure 116 Defining the positions of the perimeter segments
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5. Save the Project file.

Select the Area of Interest (AOI)
1. Zoom out so that the AOI encompasses the entire site and rotate the image to obtain the 

desired display.

2. Select the AOI tool. Select the AOI by left-clicking the upper left corner, then moving the cursor 
diagonally across the map and left-clicking the bottom right corner. Keep the AOI aspect ratio 
as close to 5:2, and as centered as possible.

3. Select the Extract AOI button.

4. Increase the Zoom on the Area-of-Interest Details field until either the Image Width or Height is 
approximately 1000, and then select OK.

Note To use the alarm zones as created in the IDS Map Manager, proceed to 
Select the Area of Interest (AOI) on page 102.

Figure 117 Selecting the Area of Interest

Figure 118 Extracting the Area of Interest
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5. When you are prompted to Download Missing Tiles select Yes. 

6. Once the Map Extraction is complete, select OK.

7. Go to the Project menu, and select Export > Definition file(s)...
Use the Browse button to select a folder in a known location (or create a folder) and then 
select Export. When the export process is complete, select OK.

8. Delete the IDS zone definition.txt file from the target folder.

9. Verify that three configuration files were exported to the specified folder (IDS map 
calibration.txt, IDS map image.jpg, IDS perimeter definition.txt) and check the map image 
(open the jpg file). 
If there is no map image, you must reselect the AOI and extract the map at a lower zoom level.

10. Save the Project, and close IDS Map Manager.

Importing Configuration Files into the FiberPatrol IDS software
1. Save the three configuration files that were exported from IDS Map Manager to removable 

media.

2. On the FiberPatrol sensor unit, navigate to C:\FiberPatrol\Configuration. Rename the existing 
files by adding ORIG to the end of the file name before the extension (e.g., IDS map 
calibration ORIG.txt).

3. On the FiberPatrol sensor unit, copy the three IDS Map Manager configuration files into 
C:\FiberPatrol\Configuration.

4. Go to the Configure menu, and select Load Configuration.
Verify that the correct map image appears in the Current Alarms sub-panel.

Note The Download Missing Tiles process can take several minutes. Wait 
until the Map Extraction Complete popup displays before proceeding.

Figure 119 Completing the Map extraction

Note The Export function creates four configuration files. However, the IDS 
zone definition.txt file is not required and must be deleted from the 
target folder before the files are imported into the FiberPatrol IDS 
software.

select OK

select Yes
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5. Go to the Help menu, and select About FiberPatrol.
Change the Site ID and Unit ID to the appropriate numbers.
Verify that there are no License Errors. 

6. Save the Configuration.

Figure 120 Verifying the Map image

Figure 121 About FiberPatrol dialog

The map image and
perimeter line created
in IDS Map Manager
display when the new
configuration files are
loaded.
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Defining the Zone Boundaries (Zone Definitions)    

1. In the Manage menu, select Zone Definition.

2. In the Zone Definition window, enter the average Start and End location of each zone from the 
Location/calibration table that was recorded during the testing, beginning with Zone 1.

3. Keep the Zone Labels in ascending order, and with the same nomenclature as used in the 
default configuration (e.g. zone1, zone2, zone3, etc.).

4. Change the Zone Names as required.  

5. Verify the Zone Types are correct (11 for fence/wall, 61 for buried cable).

6. Once complete, select Apply, and then select Replace.

Figure 122 Zone Definition window

Note Right-click a Zone line to add or delete a Zone. 
When a new zone is added, the Start Location and End Location are 0, 
the Zone Label is newzone and the zone name is New Zone. 
All zones must be assigned unique Zone Labels and Zone Names, 
including disabled zones.

Note The end location of one Zone boundary must be the same as the start 
location for the next Zone boundary (i.e., if Zone 1 ends at 100 m, then 
Zone 2 begins at 100 m). 
For a fully closed perimeter, the end point location of the final Zone must 
be the same as the start point location for the first Zone.

Note The FiberPatrol FP1150 sensor supports up to 1440 distinct alarm zones.

Note The Zone Definition dialog includes error checking to prevent errors in 
setting up the detection zones.

Note Do not change the Head End zone, Frame Duration, Filter settings (Low 
Freq, High Freq), Thresholds, or Display mode at this time. 

Note Zone Names must begin with a number for use with the Network 
Manager software (e.g, 7: West Fence, 8: West Gate).

Note Assign meaningful Zone Names, as the Zone Names are displayed 
during alarm activity and are recorded in the Event Log (e.g., for Zone 
Label zone3 enter Zone Name 3: Main Gate).
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7. Verify that the Zone Definitions are accurate.

8. Save the Configuration.

Remote Interface/Alarm output setup

There are three methods available for FiberPatrol Remote Interface Alarm output:

• Network Manager

• Relays (via NM and UltraLink I/O)

• ASCII output

1. To setup the Remote Interface connection select Configure > Remote Interface.
The Remote Communication Interface window displays.

• Select Connection is used to select which connection is being configured. 
There are five connections available: A, B, C, D and E. 
Other remote interface controls and indicators will display the parameters of the selected 
connection.

• The Enable checkbox enables or disables the remote interface connection (leave enabled). 

• The Broadcast checkbox enables or disables the transmission of data through the remote 
interface. When selected, the FiberPatrol IDS transmits data packets at regular intervals 
(leave enabled).

• Interface Mode is a drop-down menu that selects the remote interface type from the available 
options. The following are two of the standard options.

• In TCP/IP Server mode, the FiberPatrol IDS implements a TCP/IP server. It accepts a 
single connection through the default Port (4122).

Note To verify the Zone Definitions perform tests to cause alarms along the 
perimeter. Test each zone and any site features and check the Alarm log 
to ensure that each alarm is reported accurately in the correct zone at the 
proper location. Repeat the tests for any alarms that were not reported 
correctly, and make any necessary changes in the Zone Definition 
window.

Note The primary focus of this manual is on the Network Manager interface. 
Refer to Appendix d for additional Remote interface setup details.

Figure 123 Remote Communication Interface

Note All five of the connection types can be in operation simultaneously.

selectable Report Modes
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• In TCP/IP Client mode, the FiberPatrol IDS implements a TCP/IP client. It connects to a 
TCP/IP server via the specified IP Address and Port.

• The IP Address specifies the remote server’s IP address when TCP/IP Client mode is in use. 
Set to 127.0.0.1 if the server is on the local sensor unit.
The IP Address field is not used in TCP/IP Server mode. 

• The Port Number is the TCP/IP port for the remote interface connection (for server mode the 
Port Number is 4122; for client mode the Port Number must match the TCP/IP port used by 
the remote server). 

• The Report Mode field sets the data format for the selected connection.

• The Connection Status indicators display the connection status for up to five remote 
connections.

• The Remote Client field displays the identity of the remote client. 
For the TCP/IP modes the identity is the remote computer’s IP address or the DNS name.

• The Communication Monitor field is used to monitor the incoming remote interface messages 
for the selected connection.

Setting Alarm Detection Parameters
The FP1150 includes detection parameters that apply to intrusion detection (fence lift or climb and 
buried detection) and parameters that apply to fence cut detection. There are also parameters that 
are common to both types of detection (intrusion and cut). The Detection Parameters are available 
on the Signal sub-panel. There are 2 radio buttons on the Signal sub-panel that switch between 
intrusion detection and cut detection. When the Intrusion button is selected the parameters that 
apply to intrusion detection are available. When the Fence Cut button is selected the parameters 
that apply to fence cut detection are available. The common parameters are always available. 

Note Select Server mode for Network Manager Interface (NMI) applications.

Figure 124 Signal panel

 Intrusion detection
 parameters

 Fence Cut
 parameters
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Common parameters

The following parameters apply to both types of detection:

• The Frame Duration defines the time period in which new disturbance events are created. 
Shorter Frame Durations are used for flexible fences (chainlink) and longer Frame Durations 
are used for rigid fences (palisades). 

• The FP1150 includes a band pass filter to help screen out background noise. The Filter 
Cutoffs show the settings of the Low Frequency and High Frequency cut-offs. The filter 
settings are used to customize the sensor’s frequency response to the type and condition of 
the fence on which it is mounted. Correct adjustment of the Filters can increase the signal to 
noise ratio and help to screen out the ambient background noise that is always present.
The Low Frequency cut-off screens out low frequency vibrations such as the fence motion 
caused by steady wind and loose fence fabric. The High Frequency cut-off screens out high 
frequency vibrations. When the number 0 is displayed for the high frequency cut-off, it 
indicates the High Frequency cut-off is at the default value (maximum). The default settings of 
the Filter Cutoffs are factory set to provide good detection on most types of fences.

• The Disturbance Range defines the length of cable over which a current disturbance event 
can be added to by additional disturbances in the same general area. The default value is 
12 m (39 ft.).

• The Event Life is the length of time, in seconds, following an event (alarm) before another 
event (alarm) can be declared at the same location. The default value is 60 seconds.

Intrusion parameters

• The Disturbance Threshold is the minimum level that a localized disturbance must reach to be 
accumulated and counted towards alarm generation. The Disturbance Threshold is indicated 
by a red line in the disturbance level display. This sets the sensitivity of the system together 
with the Alarm Threshold. The default value is 5.

• The Alarm Threshold is the minimum disturbance count that must accumulate within a location 
range and a time range (determined by the Disturbance Life setting) in order to generate an 
alarm. The Alarm Threshold determines the sensitivity of the system together with the 
Disturbance Threshold. The default value is 10.

• The Duration Threshold is the minimum event duration (in seconds) required in order to 
declare an alarm. The Duration Threshold is used for rejecting events that are too brief to be 
considered a valid intrusion attempt. The default value is 2 seconds. 

• The Disturbance Life is the length of time, in seconds, for which any localized disturbance is 
retained. If the total amount of disturbance in the localized area does not reach the alarm 
threshold in this period, the accumulated disturbance is discarded. The default value is 10 
seconds.

• The Disturbance Mask is used to prevent a single disturbance event from being recorded as 
additional disturbances due to continuing reverberations caused by the initial disturbance. The 
default value is 0.3 seconds.

Fence Cut parameters

• Fence Cut Enable is available only on the Zone Definition Window. Fence Cut Enable must be 
enabled to use the cut detection parameters (1 = enabled, 0 = disabled).

• The Cut Disturbance Threshold is the disturbance signal level that must be reached to be 
counted as a cut event. (default = 8)

• The Cut Alarm Threshold is the cut disturbance event count that must accumulate to cause a 
Cut Alarm. The Cut Alarm Threshold must be reached within a defined time period (Cut 
Window) and within a defined length of cable (Disturbance Range). (default = 8).

CAUTION Do not adjust the Frame Duration or the Filter Cutoffs without direct 
technical support.
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• The Cut Window is the time period (in seconds) over which a disturbance event is added to 
the cut count for alarm generation. Each time a cut event is detected, additional time is added 
to the Cut Window time. When the Cut Window time expires the disturbance event count is 
reset. (default = 30 seconds)

• The Cut Profile defines the amount of time that is added to the Cut Window each time a cut 
event is recorded. The Cut Profile is expressed as a portion of the Cut Window setting. 
(default = 0.2) At the default settings 20% of the Cut Window value is added to the time 
remaining in the Cut Window (20% of 30 seconds = 6 seconds). 

• The Cut Disturbance Mask is the time (in seconds) that must pass after a fence cut event 
occurs before the next fence cut can be recorded. (default = 1 second)

Intrusion simulation tests

To test the FiberPatrol sensor you conduct intrusion simulations. Using the Save Raw Data 
function, thoroughly test the detection along the full length of the sensor cable, while recording 
each test. Use the Load Raw Data function to playback the recorded data and adjust the detection 
parameters if any of the test intrusions fails to report an alarm simulation. 

Once the intrusion testing is completed, briefly run the Save Raw Data function during periods of 
inclement weather (30 seconds to 1 minute max.). Replay the saved data and adjust the detection 
parameters if bad weather causes an unacceptable nuisance alarm rate (NAR). Once the system 
is detecting all intrusion simulations and the NAR is acceptable, the sensor is properly calibrated. 
Update the Factory Configuration to include the processor’s current settings.

Simulated cut intrusion tests

The easiest method for simulating a cut intrusion is to strike the fence with the blade of a medium 
sized screwdriver. Hold the screwdriver by the handle, and flip your wrist to strike a fence wire with 
the blade of the screwdriver. The metal on metal contact generates an impulse that is similar to the 
cutting of a fence wire. Strike the fence firmly, but do not use excessive force. Try to use a 
consistent amount of force each time you strike the fence.

Rather than striking the fence, you can also simulate a cut intrusion by weaving a length of fence 
wire tightly into the panel and then cutting the inserted wire. Both methods generate a signal that is 
similar to the response of an actual cut intrusion. An actual fence cut also creates a significant 
amount of secondary fence noise as the cut section of wire pulls apart.

Simulated climb intrusion tests

For a simulated climb intrusion, the best method is to actually on climb the fence. It is not 
necessary to climb over the fence. The tester simply needs to climb on the fence for as long as it 
takes to generate an alarm (typically less than 3 seconds).  

CAUTION The Save Raw Data function typically creates very large files. Do not use 
the Save Raw Data function for extended periods. When conducting 
intrusion tests, start the Save Raw Data at the beginning of each test, and 
stop it when the test is completed. 

Note Conduct an initial climb intrusion test to determine how long it takes to 
generate an alarm at your site.

CAUTION Use protective gloves and suitable footwear during the climb intrusion 
testing.
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If climbing on the fence is not possible, dragging a screwdriver across the surface of the fence can 
be used as a climb simulation. Place the blade of a screwdriver against the fence fabric and drag 
the screwdriver across the fence panel while applying light pressure. Remain stationary during this 
test (do not walk along the fence).

Buried cable intrusion tests

To simulate third party interference (TPI) dig in the soil above the sensor cable for at least 10 
seconds. (Use caution during the digging activity to prevent damaging the sensor cable.

For above ground intrusion simulation, beginning about 5 m (16 ft.) away from the sensor cable 
walk across the cable path at a normal pace.

For tunneling detection use a hammer to repeatedly strike a 1/2 in. steel plate that is placed on the 
ground directly above the sensor cable.

Setting the full cable Sensitivity Thresholds
The full cable Sensitivity Thresholds are software settings that control the sensitivity of the entire 
sensor. When correctly set, the full cable Sensitivity Thresholds make the FP1150 sensor sensitive 
enough to detect an intruder, while keeping nuisance alarms to a minimum. The following 
procedure requires two people.

1. Go to the Signal sub-panel.

2. Set the Disturbance Life to 15 seconds, and the Event Life to 60 seconds.

3. Have a test subject go to a straight section of the perimeter (away from any cable loops, 
corners, and gates), and simulate an intrusion.

4. On the FiberPatrol sensor unit, access the Signal sub-panel and observe the Disturbance 
display and Alarm status. Note the magnitude of the disturbance, and how quickly the gray 
bars turned to red (signaling an alarm). Repeat the intrusion test five times to determine how a 
typical intrusion appears on the display.

5. Raise the Disturbance Threshold and Alarm Threshold and repeat the intrusion tests, so that 
the test subject always generates an alarm during the tests at the highest possible threshold 
settings. If raising the thresholds results in a failed test (no alarm) lower the threshold 
accordingly.

• If the test disturbances are not going above the red line, reduce the Disturbance 
Threshold. 

• If the test disturbances are well above the red line, increase the Disturbance Threshold.

• If the duration of the test disturbances are not long enough to cause an alarm, but are over 
the red line, reduce the Alarm Threshold so that an alarm is generated. 

• If an alarm is generated very quickly, increase the Alarm Threshold so that an alarm is 
generated, but it takes more time to generate.

6. Save the Configuration.

Note Remove any potential sources of vibrations from the vicinity of the sensor 
cable.

Note Adjusting the Detection Thresholds generally takes some trial and error. 
Test all settings multiple times to ensure that the sensor always 
generates an alarm.
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Setting zone specific Sensitivity Thresholds

Zone specific Sensitivity Thresholds are software settings that control the sensitivity of individual 
Zones. These settings enable either a higher or lower detection sensitivity for a particular zone. 
This procedure is similar to the Global Sensitivity procedure. However, the Threshold settings 
apply only to individual zones.

1. Go to the Signal sub-panel, and verify that the Disturbance Life is set to 15 seconds, and the 
Event Life is set to 60 seconds.

2. Have a test subject go to Zone 1 and simulate a series of intrusion tests (see Intrusion 
simulation tests on page 109). Observe the Signal sub-panel during the tests. 

• If the Global Sensitivity Settings are acceptable for Zone 1, proceed to Zone 2, and repeat 
the tests.

• If the Global Sensitivity Settings for Zone 1 require adjustment, proceed to step 3.

3. To adjust the Sensitivity settings for an individual zone, open the Manage menu, and select 
Zone Definition (see Figure 122).

4. To adjust the sensitivity thresholds for an individual zone, change the threshold value from the 
default value of -1 to the desired value.

5. Perform a series of intrusion tests to verify the new settings.

6. Repeat this procedure for each Zone.

7. Go to the Configuration menu and select Save Configuration (see Figure 65:).

8. On the Configuration menu, select Update the Factory Configuration.

Note If a zone requires different sensitivity settings in two sections, the zone 
must be divided into two sub-zones (e.g., Zone 7 = Zone 7a + Zone 7 b). 
If a zone requires a different sensitivity setting in the middle of the zone, 
the zone must be divided into three sub-zones (e.g., Zone 7 = Zone 7a + 
Zone 7b + Zone 7c). Each sub-zone can be assigned a different 
sensitivity setting (Threshold value) and each sub-zone can report alarms 
via the same output so the 7a, 7b and 7c sub-zones all display alarms in 
Zone 7.

Note There are three columns in the Zone Definition window related to the 
detection sensitivity settings: Disturbance Threshold, Alarm Threshold 
and Duration Threshold. If a -1 is displayed, then the Global Setting 
applies for that zone (e.g., if the global Disturbance Threshold setting is 
6, then a zone displaying a -1 in the Disturbance Threshold column has a 
Disturbance Threshold of 6). All zones use the Global Settings by default, 
unless the settings are adjusted via the Zone Definition window (all 
threshold values are initially -1).

Note You must select Apply, and then select Replace for the sensitivity 
changes to take effect.
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Setting the Environmental Compensation
Environment Compensation can be used to help screen out environmental factors like strong wind 
and heavy precipitation that can cause nuisance alarms. Environment Compensation is accessed 
through the Service menu. There are two different modes of Environment Compensation, Spatial 
and Temporal. Set Temporal Environment Compensation first.  

Temporal Compensation: 

Temporal Environment Compensation works at a localized point of the sensor and removes 
background signals based on the point’s history over a time period defined by the “Average Time” 
setting.

• Enabled? (1 yes, 0 No): Temporal Environment Compensation is applied to the cable section 
if a value of 1 is entered in this column. A value of 0 disables Environment Compensation in 
the cable section.

• Start and End Locations: The length of a section is defined by entering a start location and 
an end location. The values for the start and end locations use the same unit that was chosen 
in the System panel (meters or feet). Multiple different sections can be defined for Temporal 
Environment Compensation.

• Average Time(s): This is the time period that Temporal Environment Compensation uses for 
removing slowly-varying background signals at a location.

• % Comp: This is the degree of Temporal Compensation applied to each location. Higher 
percentage increases common-mode rejection.

• Notes: The Notes column is populated with the chosen medium of each region by default. 
However, the Notes field can be customized by the user.

Spatial Compensation: 

Spatial Environment Compensation dynamically monitors disturbance signals over a longer length 
of the sensing cable (several tens of meters) and removes common-mode disturbance signals 
caused by environmental factors. Spatial Environment Compensation compares the disturbance 
signal of a sensor at a specific location with a range of contiguous locations on both sides. This 
range of contiguous locations is defined by the “Include Length” setting. It does not compare the 
disturbance signal from the immediate locations on both sides, which are defined by the “Exclude 
Length” setting. 

Note Environment Compensation can be set to default values by selecting the 
Event Compensation checkbox on the Global Setup window.

Figure 125 Environment Compensation screens
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• Enabled? (1 yes, 0 No): Spatial Environment Compensation is applied to the cable section if 
a value of 1 is entered in this column. A value of 0 disables Spatial Environment 
Compensation in the cable section.

• Start and End Locations: The length of a section is defined by entering a start location and 
an end location. The values for the start and end locations use the same unit that was chosen 
in the System panel (meters or feet). Multiple different sections can be defined for Spatial 
Environment Compensation.

• Include Length: This is the length of cable on both sides of a location which are used to 
remove common-mode disturbance signals from a location.

• Exclude Length: This is the length of cable on both sides of a location that are excluded from 
Spatial Compensation. The Exclude Length is always less than the Include Length.

• % Comp: This is the degree of Spatial Compensation applied to each location. Higher 
percentage increases common-mode rejection.

Motion Tracking

A new class of alarms called Motion alarms can now be created. Motion alarms have a velocity 
rather than a magnitude, with a +/- indicating the direction relative the Start/End of the Sensor fiber 
(+ is toward the end of the fiber and - is toward the start). In the Log tab, the Magnitude column will 
display the velocity of motion alarms. Figure 126 shows the Motion Tracking panel.

Motion Tracking can be used to determine the location, speed, and direction of travel of objects 
moving along the length of a buried fiber installation. Example applications for Motion Tracking 
include tracking the progress of pipeline inspection gauges (cleaning pigs or scrapers) and 
monitoring the movements of trains or vehicles.

The display graph on the Motion Tracking panel is divided into 2 halves. Both halves show Active 
and Complete alarms. The top half of the graph shows objects that are moving (or have moved) in 
the negative direction (toward the start). The bottom half of the graph shows objects that are 
moving (or have moved) in the positive direction (toward the end). As Active alarms move, their 
location is updated both in the graph and in the alarm list box at the bottom of the Motion Tracking 
Tab. 

Figure 126 Motion Tracking panel
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• Active alarms are green and blink, while complete alarms are gray and do not blink.

• Alarm text includes the status (e.g. Active) and Alarm ID.

• Right-click the graph to choose whether to show Active and Complete alarms, or Active alarms 
only. 

• Selecting Default Range returns the x-scale graph range to the low and high locations of 
enabled Motion Tracking regions. (You can also double-click the graph to use this feature.)

The Tuning section contains:

• Show Motion Waterfall Graph button: Opens the waterfall graph.

• Motion Tracking Parameters button: Opens the Motion Tracking popup where the user defines 
and enables motion tracking regions. 

• Low/High Frequencies: Specify the frequency bounds used to accumulate a motion 
disturbance signal. Default values are L/H 200 Hz/0 (0 being the max. frequency available). 

The Lost Object Detection section contains:

• Object Recapture Distance: If a moving object is detected within the Object Recapture 
Distance of a previously detected moving object for which the vibration signal has been lost, 
the system shall interpret the new object as the previously lost object. 
(default = 150 m (492 ft.) 

• The Lost Object Timeout is the duration in which a lost moving object may be recaptured. 
(default = 120 seconds)

The Alarm Management Section contains:

• Create Motion Alarms: Select (check) the checkbox to create Motion alarms. Uncheck the 
checkbox for Motion Tracking to function the same as Motion Rejection did in previous 
versions of the FP1150 software (see Motion Rejection: on page 116).

• Background Rejection: Select (check) the checkbox in order to perform Motion Rejection in all 
enabled Motion Tracking regions.

• Clear All Motion Alarms button: Clear all alarms of the Motion event type. 

• Clear Motion Alarm button: Clear a single Motion alarm. 

Waterfall Graph

The Waterfall Graph shows the disturbance signal for one of the two sensors. There is a radio 
button selector in the lower right hand corner of the window that selects the sensor being viewed. 
There is a View Motion Data checkbox. If selected (checked) the motion disturbance signal will be 
shown, and the path and Alarm ID of any current moving objects will be drawn on the graph. If not 
checked, the Intrusion/Fence Cut disturbance signal will be shown, and no moving objects will be 
identified on the waterfall graph.
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Motion Tracking parameters

The first column in the Motion Tracking parameters screen lists the section numbers. A section is a 
part of the sensor cable where Motion Tracking can be applied to reject vibrations caused by 
nearby motion. Section number 0 is the first section of cable in which Motion Tracking has been 
applied. Section number 1 is the second section, etc. Any number of sensor cable sections can be 
defined and each section can use different settings. The defined sensor cable sections do not 
have to be contiguous. Other columns are explained below:

• Enabled? (1 yes, 0 No): Motion Tracking is applied to the section if a value of 1 is entered in 
this column. A value of 0 disables the section.

• Start and End Locations: The length of a section is defined by entering a start location and 
an end location. The values for the start and end locations use the same unit that was chosen 
in the System panel (meters or feet). 

• Disturbance Threshold: Disturbance signals above this threshold setting are analyzed to 
determine a valid Motion event. default = 3

• Distance Threshold: The moving object must travel at least this distance to generate a 
Motion alarm. This value uses the same unit that was chosen in the System panel (meters or 
feet). default = 150 m (492 ft.)

• Proximity Distance: New disturbances may only be added to moving objects if they occur 
within this distance of the most recent update. This value uses the same unit that was chosen 
in the System panel. default = 40 m (131 ft.)

• Proximity Time: New disturbances may only be added to moving objects if they occur within 
the Proximity Time of the most recent update. 

Figure 127 Waterfall Graph

Figure 128 Motion Tracking parameters
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• Reject Window: Defines the period of time to delay disturbance frames before considering 
them for rejection. Rejection occurs if the source of the disturbance is determined to be a 
moving object. default = 11 seconds

• Speed Minimum: The Minimum speed a moving object must travel in order to generate a 
Motion alarm. The unit of speed is either km/hr or mi/hr depending on the unit chosen in the 
System Panel. The current unit is displayed in the Speed Min column header. 
default = 3 km/hr. (1.86 mph)

Motion Rejection:

In some installations, the fence on which the sensor cable is installed, runs closely alongside a 
roadway or railroad. If heavy vehicles or train traffic passing by the fence cause nuisance alarms, 
then Motion Rejection should be used to prevent these nuisance alarms. To enable Motion 
Rejection, define sections in which Motion Rejection will be applied.

To set up Motion Rejection without creating Motion alarms:

1. Check Background Rejection on the Motion Tracking tab.

2. Uncheck Create Motion Alarms on the Motion Tracking tab.

3. Click the Motion Tracking Parameters button on the Motion Tracking tab.

4. Create one or more regions in the Motion Tracking table.

5. Enable the region(s) by entering 1 in the Enabled column.

Save Raw Data

An advanced user can use the Save Raw Data function to help fine-tune an FP1150 sensor. Use 
the Save Raw Data function during test simulations, and then replay the saved data via the Load 
Raw Data function. Make small adjustments to the detection parameters to find the optimal 
settings whereby each test is detected, while nuisance alarms are minimized. Save Raw Data can 
also be used during periods of inclement weather to further reduce nuisance alarms. The Save 
Raw Data feature creates text files which are saved into the Data Folder (C:\Data). The text files 
can be sent to Senstar technical support for analysis. When enabled, the Save Raw Data function 
saves the configuration folder and creates a sub-folder every 5 minutes. 

Note To disable both Motion Tracking and Motion Rejection enter a 0 in each 
defined region.

CAUTION The Save Raw Data function typically creates very large files. Do not use 
the Save Raw Data function for extended periods. When conducting 
intrusion tests, start the Save Raw Data at the beginning of each test, and 
stop it when the test is complete. Contact Senstar for direct technical 
support before using the Save Raw Data feature.
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Load Raw Data

An advanced user can use the Load Raw Data function to help fine-tune an FP1150 sensor. Use 
the Load Raw Data function to replay the saved data from detection tests. Make small adjustments 
to the detection parameters while replaying the saved data to find the optimal settings. Data 
recorded during periods of inclement weather can also be loaded and played back. This can 
further reduce nuisance alarms by making small adjustments to the detection parameters that will 
exclude the environmental signals from counting towards alarm generation.

The Load Raw data dialog allows you to select all or a part of the saved data. Use the 2 sliders to 
specify the data for playback. The Repeat checkbox will replay the selected data when checked.

Frequency History Window

The FiberPatrol FP1150 Series sensor includes a Frequency History window for each sensor, 
under the Service menu. In Zone Mode, the Frequency History window enables an advanced user 
to view signal amplitudes on a zone by zone basis. In Location Mode, you can specify a location 
and view the signal amplitudes at that location.  

Figure 129 Save Raw Data/Load Raw Data screen

Figure 130 Frequency History window
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Additional installer level settings

The Installer access level can verify the health of the system by viewing the Signal graph in linear 
mode and dB mode. Linear mode shows the COTDR signal from the cable and dB mode shows 
the approximate loss in the cable and the location of the end (see Figure 131).

The Refresh button resets the net signal calculation (used for the net signal status checkpoint and 
the net signal graph on the system tab).

The Global Setup button is used during the initial configuration to specify the maximum length of 
each sensor and the type of installation medium. Once the correct medium is selected a number of 
default parameters are updated accordingly, including Environmental Compensation. 

The Troubleshooting button can be used to disable the SafeStart feature once the sensor 
connections are verified. It also enables an advanced user to troubleshoot the system by checking 
the status of the hardware components of the SU.  

Configuration File Safety Backup

Once the system is setup and configured, it is strongly recommended that a backup copy be made 
of the configuration folder: C\FiberPatrol\Configuration. Save the Configuration folder to 
removable media so the configuration data can be reloaded in the event of a catastrophic system 
failure.

Note Do not use the Signal graph in place of the OTDR scanning during the 
system installation.

Note DO NOT adjust the Troubleshooting Settings without direct technical 
support.

Figure 131 Additional settings

Use the signal graph to verify
the health of the system
in Linear mode or by dB

The Global Setup can
be used to simplify sensor

calibration by specifying the

The Refresh button resets the
system’s net signal calculation

The Troubleshooting button
displays the Troubleshooting
dialog which can be used to

verify the system hardware
Skip SafeStart and

installation type and medium



FiberPatrol FP1150 Product Guide Page 119

6 Operator’s functions

FiberPatrol Definitions

Term Definition

Disturbance Disturbance is a detected and localized mechanical motion or vibration in the 
protected area.

Event When the total amount of disturbance within the specified limits of location and 
time exceeds the event threshold, the disturbance is declared to be an event.

In Progress An event remains in progress as long as the disturbance continues within a 
specified distance of the event location. The attributes of the event, including 
the event location, may be updated while the event is in progress. There may be 
more than one event in progress at different locations at the same time.

Complete An event expires and becomes complete if the disturbance stops for a period 
longer than the event life time. If the disturbance resumes at the same location, 
it may be declared a new event.

Alarm An alarm is a notification of an event, either in progress or complete. An alarm is 
generated for each event, once the event is declared (one event = one alarm).

Time of Alarm The date and time the alarm was generated. The alarm time may differ from the 
time the disturbance began.

Current Alarms An alarm remains current and is reported until the alarm is acknowledged or the 
system is disarmed. (The event may be in progress or complete.)

Clear Alarm
(Acknowledge)

An alarm is cleared (acknowledged) by an operator’s action. The operator must 
perform all actions defined by the facility’s alarm handling procedures before 
clearing the alarm. A cleared alarm is removed from the current alarms list and 
is no longer reported. If the event remains in progress, it can generate a new 
alarm, which will then be reported.

Event Location The average location of the disturbance which caused the event. The event 
location is refined while the event is in progress.

Event Duration The length of time between the beginning and the end of the disturbance.

Event Level The cumulative amount of disturbance over the event duration.
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Auto-start routine
• When the electrical power is turned on or restored, the FiberPatrol system will automatically 

power up.

• The FiberPatrol sensor unit auto-boots into a Windows administrator account.

• After a one-minute delay for the initialization process to complete, the FiberPatrol IDS main 
panel opens, with the FiberPatrol login window displayed.

• If login information is not entered within one minute, the FiberPatrol IDS will start at the 
Operator access level with the user name “LocalOperator”. 

Manual Windows login

The FiberPatrol system can be configured for manual startup. In this case, the Operator/
Supervisor has to login to Windows with a User Name and Password. The Windows user accounts 
are controlled by the system Supervisor. 

Starting the FiberPatrol software

Double-click the Launch FiberPatrol shortcut icon on the desktop.
OR
Select start\programs\FiberPatrol\Launch FiberPatrol.exe.

The default location of the FiberPatrol software is: 

C:\FiberPatrol\FiberPatrol.exe

Enter your user name and password, select your access level, and then select OK.

Once you have entered a valid password for the selected access level, the FiberPatrol software 
will proceed with the initialization sequence. If an incorrect password was entered or the Cancel 
button was selected, the program will shut down. Once the initialization sequence is completed, 
the system is armed.

FP1150 User access levels

The Operator access level is used for routine operation and for monitoring perimeter activity. The 
Operator level provides access to the Alarms and Alarm History panels, and partial access to the 
System menu. 

The Supervisor access level is required for adjusting system parameters and settings, changing 
passwords, accessing the FiberPatrol log files, and for shutting down the system. The Supervisor 
level provides access to the Alarms, Alarm History, Log and Signal sub-panels, and partial access 
to all menus.

Figure 132 FiberPatrol login window

Enter Username (not required)

Enter Password

Select the level of access
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The Installer access level enables the system installer or a maintenance technician to configure 
the FiberPatrol system, to diagnose the system operation, to optimize the hardware and software 
performance of the FiberPatrol sensor, and for shutting down the system. The Installer level 
provides access to the Alarms, Alarm History, Log, Signal and System sub-panels, and access to 
all menus.

The Factory Service access level is not available.

FiberPatrol Operator Control Panel
The FiberPatrol Operator Control Panel provides access to the Alarms and the Alarm History sub-
panels. The Alarms Sub-Panel is the default display of the FiberPatrol Software Interface. It 
displays detailed attributes of current alarms and enables the Operator to process alarms via the 
Clear Alarm button. The menu bar at the top of the panel provides access to some functions. Menu 
items that are not available to the Operator access level are grayed out. 

Status Panel

The Status Panel at the bottom of the Window contains three fields that are common to all sub-
panels - System Status, Alarm Status, and Alarm Location. The System Status field displays 
Armed to indicate the system is operating properly. The Alarm Status field indicates any current 
alarms. The Alarm Location field displays the location of the current alarm. 

Figure 133 Operator Control panel (no alarms)
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System Status

The System Status field displays information on the current state of the FiberPatrol system (see 
Figure 134).

The System Status messages include:

• Initializing (steady) Is displayed at system start-up. During the initialization period the system 
is inactive. 

• Armed (steady) is the normal operating state. The system is ready and is monitoring for 
intrusion events. 

• Cable Cut (steady) is displayed when the system detects that the sensor cable has been cut 
or damaged (S1 and S2). Intrusion detection capability may be lost over a portion of the 
perimeter.

• Warning (flashing) The system is functioning in a distressed operating state. System 
operation is compromised; however, the intrusion detection ability is retained. 

• Disarmed (flashing) System operation is severely compromised and the intrusion detection 
capability is lost.

Alarm Status field

The Alarm Status field displays the current number of alarms:

No Alarms (steady) There are no current alarms.

Alarm 2 of 2 (steady) There are 2 current alarms, and the second alarm is selected.

Alarm 1 of 3 (flashing) There are 3 current alarms at least one of which is in progress, and the first 
alarm is selected.

Alarm Location field

The Alarm Location field displays the location of the currently selected alarm. If there are no 
current alarms, the Alarm Location displays None. By default, the Alarm Locations are based on 
the location of the event according to the length of the sensor cable. The software can be 
configured to display the name/number of the Zone and the GPS coordinates in the Alarm 
Location field. 

Figure 134 Operator Alarms panel (2 alarms)

System Status, Alarm Status,
and Alarm Location fields

Alarm data for current alarms

Perimeter map alarm display
(2 alarms) 

(location-based alarm reporting)
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Menu bar
The Menu bar provides access to the system functions, based on the access level of the current 
user. Menus and menu items that are not available to the current user are grayed out. For the 
Operator, some of the functions on the Systems menu and Help menu are available.

The following is a summary of the FiberPatrol Operator menu items:

System menu

Login - displays the login window, used to change the access level while the system is running

Exit - requires Supervisor or Installer access level to shut down the system

Help menu

About - displays information about this FiberPatrol system

Alarms Sub-Panel

Alarm List

The Alarm List includes all current alarms in reverse chronological order. The most recent alarm is 
displayed at the top of the list. New alarms are added to the top of the list as they are generated. 
Cleared alarms are removed from the list immediately. Uncleared alarms are removed from the list 
according to the system’s Alarm Auto Clearing settings. Alarms can be selected from the alarm list 
by selecting the corresponding line on the list. The selected alarm is highlighted, and its location is 
displayed on the Map and in the Status Panel Location field. To clear the currently selected alarm, 
select the Clear Alarm button or double-click the highlighted line in the Alarm Attributes field. 

Alarm Attributes

Each line of the Alarm List includes the details of the corresponding alarm, including a unique 
Alarm ID number, the Date and Time, the Duration, the Status (in progress or complete), the Level 
(signal strength), the Type, the Location, the Zone and the Coordinates, if applicable. 

Map Display

The Map Display is a static image of a map, a photo, or a drawing of the site, which includes an 
overlay of the protected perimeter. The locations of any current Alarms are displayed on the 
perimeter line. The location of the currently selected alarm or, the most recent alarm is displayed 
as an explosion. Other Alarms are displayed as red dots.

Figure 135 FiberPatrol Operator menus

Grayed out menus and menu items

System and Help menus available

are not available
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Clear Alarm button

The Clear alarm button is used to acknowledge alarms. Selecting the Clear Alarm button displays 
the alarm dialog window (see Figure 137) for the currently selected alarm. The alarm dialog 
window is used to enter details about the selected alarm (i.e., the alarm cause and response).

Operator actions

1. Select an alarm by left-clicking the corresponding line in the Alarm List.
When a new alarm is generated, it is added to the top of the Alarm List and selected 
automatically.
The location of the alarm is displayed on the Map and in the Status Panel Location field.

2. Select the Clear Alarm button.
Refer to the facility’s alarm handling procedures for details on processing alarms.

3. Enter the appropriate details in the Alarm Dialog.

4. Select the Clear Alarm button on the Alarm Dialog.

Alarm Dialog details

The Alarm Dialog includes: 

• The alarm details contained in the Alarm List.

• An Established Cause field used by the Operator to enter a description of the cause of the 
alarm.

• A field used by the Operator to describe the actions taken.

• A Clear Alarm button to clear the alarm. 
Once cleared, the alarm is removed from the Current Alarms list. 
Cleared alarms are accessible through the Log sub-panel (requires Supervisor access level). 
The time the alarm was cleared and the Operator’s comments are included in the Event Log.

• The Apply button saves the Operator’s comments and closes the Alarm Dialog without 
clearing the alarm. 
Additional comments can be added and the alarm can be cleared later.

Figure 136 Alarms Sub-panel

Note If the Operator does not clear an alarm within 24-hours, the alarm is 
cleared automatically (at the default Alarm Auto Clearing setting).

current unselected alarms

left-click to select alarm

selected alarm location

current alarm details

selected alarm status & location

select Clear Alarm button to
display the Alarm Dialog
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• The Cancel button discards the Operator’s comments and closes the Alarm Dialog without 
clearing the alarm.

Once the alarm is cleared, the Alarm Dialog closes and the selected alarm is removed from the 
Current Alarms list and Map Display. The details of the cleared alarm are accessible through the 
Alarm Log on the Log sub-panel for the remainder of the day (until archived). The details of the 
cleared alarm remain accessible through the archived log files.

The Alarm Dialog window has a display time limit of five minutes. If the Alarm Dialog closes 
because the time limit is exceeded, any text entries will be retained but the alarm will not be 
cleared. 

Alarm History Sub-Panel
The Alarm History sub-panel provides an overview of the alarms that were generated over the 
24-hour period beginning last midnight (24-hour limit). All events are shown regardless of whether 
the corresponding alarms have been cleared. The events in progress are shown as red dots, the 
completed events are shown as yellow dots and current disturbances (not yet events) are shown 
as gray dots. The horizontal axis of the display graph is the location and the vertical axis is the 
time. The Alarm History sub-panel is provided for information purposes, there are no actions 
associated with this sub-panel. The Show Waterfall Graph button displays the disturbance signals 
in a different format.

Figure 137 FiberPatrol Alarm Dialog

Figure 138 Alarm History Sub-Panel
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7 Supervisor’s functions

The Supervisor functions enable the fine-tuning of system parameters and operation, as well as 
simulating alarms and system status, and password maintenance.  

Log Sub-Panel

The Log sub-panel includes detailed information on the intrusion events and system activity that 
have occurred during the 24-hour period beginning last midnight (24-hour limit). The Alarm Log 
table contains the attributes of all alarms that have occurred since last midnight. New alarm entries 
are added at the top of the list as they occur. These entries are copied from the Alarm List on the 
Alarms sub-panel.

The Event Log list contains information on system events, including logins, system initialization 
reports, hardware performance notifications, alarm clearing activity, and operator text entries. The 
Event Log list also includes the System Checkpoints details (pass or fail). The alarm and event 
information is saved to the hard drive (archived) and cleared from the Log display at midnight, as 
well as each time the FiberPatrol sensor unit is shut down. The archived Log Files are permanent 
records and can be used for reviewing the FiberPatrol system activity beyond the current 24-hour 
time window. 

Figure 139: FiberPatrol Supervisor access level display

Note The details on the Alarms sub-panel and the Alarm History sub-panel are 
the same as the details provided in the Operator’s functions.

sub-panel access tabs

menu access

Clear All button available
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To add a text entry to the Event Log, select the Add Entry button.

An Event Log Entry dialog displays in which comments can be added to the Event Log (see Figure 
141:). To save the entered data, select Add Entry. For entries that are specific to an alarm, include 
the alarm reference number. Once saved, the entry cannot be modified. To close the Add Entry 
dialog without saving the comments select the Cancel button. 

The Signal sub-panel

The Signal sub-panel displays detection parameter settings and includes three Data Displays that 
provide a graphical representation of the detected disturbances based on time or location 
(Disturbance, Count). The two top graphs display data for both alarm types at all times. The 
bottom graph displays data for the selected intrusion type. Each alarm type is color coded for easy 
identification, red for intrusion and green for fence cut. The system supervisor can adjust the 
settings and view the results on the signal display graphs. The two radio buttons on the top left 
side of the Signal sub-panel are used to display the desired detection parameters and disturbance 
type (intrusion or fence cut). Figure 142: shows the FP1150 Signal sub-panel. 

Figure 140: Log sub-panel

Figure 141: Event Log Entry dialog

Note Do not adjust the Filter Cutoffs without direct technical support. A value of 
0 in the High Frequency display box indicates that the High Frequency 
cutoff is set at the maximum value.

Event log details

Add Entry button

Alarm Log table
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Disturbance signal display graphs

The upper Disturbance graph displays the maximum received disturbance signal from the selected 
zone for both alarm types. Select a zone from the Display Zone dropdown and the disturbance 
signal from the selected zone is displayed on the graph.

The middle Disturbance graph displays the maximum disturbance level from the section of cable 
specified on the bottom graph over time. The data shown is the maximum disturbance over the 
location range defined in the bottom graph at the time the disturbance was created. The middle 
graph displays both alarm types at all times. The middle Disturbance graph also includes the 
ability to play back disturbance data over the previous 10 minutes. 

Right-click the graph, and select View Playback Panel. The panel is displayed below the graph. 
The Playback panel includes:

• Rewind - back one minute

• Pause

• Display - Indicates the time (in minutes back) of the disturbance data being viewed. Displays 
Live if data is current.

• Forward - forward one minute

• Return to live data

The text Playback in progress appears in the upper right corner of the graph when the user is no 
longer viewing live data.

The Count graph indicates all instances of localized disturbances that exceed the Disturbance 
Threshold for the selected alarm type. A disturbance that cannot be localized is ignored. Each 
disturbance is indicated by bars that are placed at the disturbance’s locations. For the FP1150 
system, the width of each bar corresponds to a 10 m (33 ft.) location range. The height of each bar 
indicates the disturbance count within that location range. A disturbance that is not yet associated 
with an event is indicated by gray bars. When an alarm is generated, the corresponding 
disturbance bars change to red. 

The Detection Thresholds and Detection Window parameters set the conditions for alarm 
generation. Unassigned (gray) disturbance bars are discarded at the end of the Disturbance Life 
time setting. Event (red) disturbance bars are discarded once the corresponding event is 
completed, depending on the Event Life time settings.

Disturbance History display

Selecting the Waterfall button opens 2 waterfall graphs of Sensor 1 and sensor 2.

Figure 142: Signal sub-panel
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Supervisor menus
The Supervisor access level provides access via the menu bars to various functions that enable 
system configuration and test.

System menu

System > Login - Displays the Login Dialog that is used for changing the Access Level while the 
FiberPatrol software is running. If an incorrect password is entered or the Cancel button is 
selected, the software continues to run with the same Access Level. 

System > Export Log Files - Saves the contents of the system logs into Log Files and clears the 
system logs. 

System > Export Image - Saves an image (jpg) of the current window.

System > Exit - Shuts down the FiberPatrol software (displays login dialog for password entry).

Manage menu

The Manage menu provides access to the Clear All Alarms, Zone Masking, Zone Definition, 
Change Password and Test Alarm functions.

Manage > Clear All Alarms - Clears all current alarms without displaying the Alarm Dialog. This 
function is available on the Alarms sub-panel as the Clear All button.

Manage > Zone Masking - see Zone Masking (Access) on page 133.

Manage > Zone Definition - see Zone Definition on page 131.

Manage > Change Password - see Password maintenance on page 133.

Manage > Test Alarm > Intrusion/Fence Cut - The Test Alarm function is used to simulate an alarm 
(either an intrusion alarm or a fence cut alarm). This function generates a simulated alarm at a 
random location, or at a selected location, and is generally used for demonstration, personnel 
training and functionality verification. 

Configure menu

Configure > Save Configuration - Saves the current system settings into the configuration file. 

Configure > Load Configuration - Loads settings from the configuration files. Used for updating the 
FiberPatrol IDS after the configuration files have been externally modified or replaced. 

Figure 143: FiberPatrol Supervisor’s menu bar

Note System settings that are available to the Supervisor access level are 
automatically saved to the configuration file.
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Configure > Alarm Auto clearing - see Alarm Auto Clearing on page 134.

Configure > Remote Interface - see Remote Interface on page 134.

Configure > Hardware Interfaces - Hardware Interfaces is a legacy holdover from previous 
versions of FiberPatrol, and does not apply to the current system.

Configure > Reset Controller - Resets the connection to the light signal hardware.

Configure > Factory Configuration > Revert - Resets the system configuration to the original 
system settings when used at the Supervisor access level.
Configure > Factory Configuration > Update - Updates the Factory settings to the current system 
settings when used at the Installer access level.

Service menu

Service > Simulate Cut - Opens a dialog that enables various cable cut scenarios to be simulated 
for demonstration, personnel training, and functionality verification.

Service > Status - Opens a dialog that shows the current system status, also enables the 
simulation of various system failures for demonstration, personnel training, and functionality 
verification.The Status dialog includes a Raid Alerts button to check the status of the Raid hard 
drives (see System Status Reporting on page 70).

1. Select Service > Status.

2. Select the Raid Alerts button on the Status dialog.

3. Verify that there are no Raid Alerts.

Service > Frequency Display - see Frequency History Window on page 117.

Service > Environment Compensation - see Setting the Environmental Compensation on page 
112. 

Service > Save Raw Data - see Save Raw Data on page 116

Service > Load Raw Data - see Load Raw Data on page 117

Supervisor functions

Zone Definition

The Zone Definition window displays a table of Zone assignments and properties (see Figure 
145:). (A displayed value of -1 indicates that the global setting applies to the parameter.)

1. Select Manage > Zone Definition.

2. Select a table cell to edit the Zone’s attributes. 

Figure 144: FiberPatrol RAID Alerts dialog
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3. Right-click on the table to add/delete Zones. 

4. Save the Zone definition by selecting the Apply button.

• The Start Location and End Location define the location range (length) of the corresponding 
zone. 

• The Location value of -1000 is reserved for the Head End equipment.

• Multiple table lines can be used to assign more than one location range to a zone.

• The Zone Label and Zone Name are text strings which identify the zone. The Zone Label 
cannot include any spaces. Each zone requires a unique Zone Label and Zone Name.

• In the Zone Type column, the first digit identifies the sensor type (1 = fence mount, 6 = buried 
cable). The second digit indicates if the zone is currently active (1), or masked (0). 
Zone Type does not apply to the Head End zone.

• The Fence Cut Enable turns ON (1) or OFF (0) fence cut detection.

• The Frame Duration defines the time period in which new disturbance events are created. 
Shorter Frame Durations are used for flexible fences (chainlink) and longer Frame Durations 
are used for rigid fences (palisades).

• The Low Freq and High Freq parameters in the Zone Definition window are the same as the 
Filter Cutoffs on the Signal sub-panel, The Filter Cutoffs are used to customize the sensor’s 
frequency response to the type and condition of the fence on which it is mounted. Correct 
adjustment of the Filters increases the signal to noise ratio and helps to screen out the 
ambient background noise that is always present. The Low freq cutoff (high pass filter) is used 
to screen out low frequency vibrations such as the fence motion caused by wind and loose 
fence fabric. The High freq cutoff (low pass filter) is used to screen out high frequency 
vibrations that can be caused by nearby machinery. The default settings of the Filter Cutoffs 
typically provide good detection on most types of fences (High freq cutoff default = 0 
maximum). A value of -1 indicates that the global threshold applies to the zone. 
These settings do not apply to the Head End zone. 

• The Disturbance Threshold, Alarm Threshold, and Duration Threshold values define zone-
specific threshold settings used to make local sensitivity adjustments. A value of -1 indicates 
that the global threshold applies to the zone. 
These settings do not apply to the Head End zone.

• The Disturbance Life, Disturbance Mask, and Disturbance Range values define zone-specific 
event timing and location settings used to make local adjustments. A value of -1 indicates that 
the global setting applies to the zone. 
These settings do not apply to the Head End zone.

• The Cut Distb Threshold, Cut Alarm Threshold, Cut Window, Cut Profile, and Cut Distb Mask 
are parameters that affect Fence Cut detection. These zone specific parameters are available 
for use when Fence Cut Enable is ON (1). A value of -1 indicates that the global setting applies 
to the zone.

Figure 145: FiberPatrol Zone Definition dialog

Note  Do not adjust the Filter Cutoffs without direct technical support.
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These settings do not apply to the Head End zone.

• The Display Mode parameter controls the visual annunciation of the alarms for a zone, 
including the appearance of the alarms on the site map, and the information shown in the 
Event Location indicator. The following table includes the Display Mode values and their 
meanings (a value of -1 indicates that the global setting applies):

Zone Masking (Access)

A Zone can be Masked to prevent alarms from being reported in that Zone.

1. Select Manage > Zone Masking.

2. Select the Zone that will be Masked.
(All Zones can be Masked by selecting De-Activate All).

3. Select De-Activate to Mask the selected Zone.
OR

4. Select Schedule to setup a Schedule for when the Zone will be Masked automatically by the 
system.

Password maintenance

The Change Password dialog enables the Supervisor to assign and change passwords for system 
users. There is one password available for each level of user access. 

Site Map Display

Not displayed Point Alarm Zone Highlight Both

Location 
Display

Zone Name 4 5 6 7

Location
absolute/relative

8/24 9/25 10/26 11/27

GPS
decimal/deg.min.sec

9/96 33/97 34/98 35/99

Zone & Location 12/28 13/29 14/30 15/31

Zone & GPS 36/100 37/101 38/102 39/103

Figure 146: FiberPatrol Zone Masking
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1. Select Manage > Change Password.

2. Select the Access Level for the User.

3. Enter the User’s Old Password.

4. Enter the New Password.

5. Re-enter the New Password.
A dialog displays indicating the password was changed successfully.

Alarm Auto Clearing

This dialog enables the Supervisor to setup the Alarm Auto Clearing function. Select 
Configure > Alarm Auto Clearing to setup automatic alarm clearing (no operator action required). 
The default setting is for alarms to be cleared automatically after a 24 hour period. The length of 
time can be changed, and alarms can be auto-cleared when they are completed. The Allow Active 
Alarms to be Automatically Cleared checkbox enables the automatic alarm clearing of an alarm 
that is in progress after the Alarm Life Time expires (see Figure 148:).

1. Check the Automatically Clear Alarms After checkbox.

2. Specify the time period after which the Alarms will automatically clear.
OR
3. Check the Upon Completion checkbox for alarms to clear automatically when completed.

4. Apply the changes.

Remote Interface

Select Configure > Remote Interface to display the Remote Communications Interface dialog. This 
dialog provides access to the Remote Interface Controls. 

Figure 147: FiberPatrol Change Password dialog

Figure 148: FiberPatrol Alarm Auto Clearing Settings
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Figure 149: FiberPatrol Remote Communication Interface Settings
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a System component list

Component Part Number Description

FiberPatrol sensor unit FP115040U FiberPatrol sensor unit for up to 40 km of cut-immune detection 
processing
up to 80 km of non cut-immune detection processing
requires per meter activation license

FiberPatrol sensor unit FP115040H FiberPatrol sensor unit for up to 40 km of cut-immune detection 
processing (fiber connections compatible with FP1100, FP 1400 
and FP6100)
up to 80 km of non cut-immune detection processing
requires per meter activation license

Activation license FP-PML-40 Per-meter activation license applicable to FP115040U/H Sensor 
Unit. The number of meters licensed needs to cover all cable 
beyond the initial lead section (max. 500 m) including all service 
loops, isolation loops, gate bypasses, etc. Initial lead cable in 
excess of 500 m needs to be added to the licensed section. Each 
meter licensed activates both sensor channels.

Map Manager software FPSW0801-XXY Software, IDS Map Manager, FiberPatrol, metric

Map Manager software FPSW0802-XXY Software, IDS Map Manager, FiberPatrol, imperial

rack-mount keyboard, 
monitor, mouse combo

GB0296-17 rack-mount 17 in. LCD monitor with keyboard and mouse for 
maintenance access to FiberPatrol processor

rack-mount keyboard, 
monitor, mouse combo

GB0296-17 rack-mount 17 in. LCD monitor with keyboard and mouse for 
maintenance access to FiberPatrol processor

rack-mount splice tray FPEM0400 1 RU rack-mount fiber patch panel for access to additional fibers in 
the equipment room

fiber connection module FPMA0922 1 RU rack-mount enclosure with splice tray and dual end module 
for equipment room fiber optic connections

End module double FPMA0222 double end module for terminating 2 fiber sensors

outdoor splice enclosure GM0749-24 outdoor splice enclosure for up to 24 fusion splices

outdoor splice enclosure GM0749-48 outdoor splice enclosure for up to 48 fusion splices

splice consumables kit FPKT0200 components required to make up to 24 fusion splices

single-mode fiber optic 
cable

FPSP0412 single-mode fiber optic lead/sensor cable for fence applications 
(12 fibers) in multiples of 100 m (328 ft.)

single-mode fiber optic 
cable

FPSP0424 single-mode fiber optic lead/sensor cable for fence applications 
(24 fibers) in multiples of 100 m (328 ft.)

single-mode fiber optic 
cable

FPSP0436 single-mode fiber optic lead/sensor cable for fence applications 
(36 fibers) in multiples of 100 m (328 ft.)

single-mode fiber optic 
cable

FPSP0448 single-mode fiber optic lead/sensor cable for fence applications 
(48 fibers) in multiples of 100 m (328 ft.)
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armored single-mode fiber 
optic cable

FPSP0624 armored single-mode fiber optic lead/sensor cable for buried cable 
applications (can also be used on fences)
(24 fibers) in multiples of 100 m (328 ft.)

buried vault GM0748 buried vault for below ground splices and cable loops 
100 x 75 x 45 cm (39 x 30 x 18 in.)

cable ties, nylon-12 GH1210-1000 bag of 1000 UV resistant nylon-12 cable ties

cable ties, polypropylene GH0916 bag of 1000 UV resistant cable ties

cable ties, stainless steel GH1080-08 bag of 100 stainless steel cable ties 20 cm (8 in.) (requires 
installation tool)

cable ties, stainless steel GH1080-08C bag of 100 coated stainless steel cable ties 20 cm (8 in.) (requires 
installation tool)

cable ties, stainless steel GH1080-14 bag of 100 stainless steel cable ties 26 cm (14 in.) (requires 
installation tool)

cable ties, stainless steel GH1080-14C bag of 100 coated stainless steel cable ties 26 cm (14 in.) (requires 
installation tool)

cable ties, stainless steel GH1080-20 bag of 100 stainless steel cable ties 51 cm (20 in.) (requires 
installation tool)

cable ties, stainless steel GH1080-20C bag of 100 coated stainless steel cable ties 51 cm (20 in.) (requires 
installation tool)

cable tie tool GX0310 cable tie installation tool for stainless steel cable ties

wall mount P-clamps FPKT0300 package of 100 wall mount P-clamps for attaching sensor cable to 
masonry buildings and walls

cable management kit for 
swinging gate protection

FPKT0500 split conduit 1 m (3.3 ft.) section and two gear clamps for sensor 
cable installation at protected swinging gates

FiberPatrol connector 
cleaning tool kit

GX0313 fiber technician connector cleaning kit for FiberPatrol applications

FiberPatrol installation tool 
kit

GX0314 fiber technician tool kit customized for FiberPatrol applications

Contact Senstar for information on ordering FiberPatrol sub-assemblies.

Component Part Number Description
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b Specifications
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t Sensor unit part number • FP115040U/H - up to 40 km of cut-immune detection
- up to 2 X 40 km of non cut-immune detection

Power • 2 separate AC circuits, 100 - 240 V, 50/60 Hz
3rd circuit required for optional keyboard/monitor/mouse (if 
applicable)

• 200 W max. (not including optional keyboard/monitor/mouse)

Mounting • EIA-19 in equipment rack with 51 cm (20 in.) mount depth, 5 cm 
(2 in.) front space and 15 cm (6 in.) rear space

• 6 RU contiguous rack space, min. 30 cm (12 in.) above floor
4 RU - sensor unit 17.8 cm (7 in.)
1 RU - fiber connection module 4.5 cm (1.75 in.)
1 RU - keyboard/monitor/mouse 4.5 cm (1.75 in.)

Environmental • temperature: 0 to 50º C (32 to 122º F)
• humidity: 20 to 80% non-condensing

Weight • sensor unit: 23 kg (51 lb)
• fiber connection module: 5 kg (11 lb)
• keyboard/monitor/mouse: 10.5 kg (23 lb)
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Sensor cable part number • standard cable FPSP04XX (XX = no. of fibers: 12, 24, 36, 48)
• armored cable FPSP0624 (24 fibers)

Max. length per reel • FP1150 Series approximately 12 km (7.5 mi)

Fiber count • optional number of fibers: 12, 24, 36, 48 (2 required as sensor fibers, 
remaining dark fibers available for perimeter applications)

Fiber type/wavelength • single-mode; 1550 nm

Bend radius (smallest 
allowable)

• standard cable dynamic (during installation) - 22 cm (8.66 in.)
• static (during operation) - 11 cm (4.33 in.)
• armored cable dynamic (during installation) - 30 cm (12 in.)
• static (during operation) - 15 cm (6 in.)

Tensile rating • during installation - 2700 N (600 lbf)

Outside diameter/weight • standard cable 11.5 mm (0.45 in.); 75 kg/km (50 lb/kft)
• armored cable 15 mm (0.59 in.); 190 kg/km (128 lb/kft)

Optical power loss • the maximum allowable single event loss is 0.3 dB
• the maximum allowable total span loss including cable loss and 

splice losses for the FP115005U/H is 4.8 dB
• the maximum allowable total span loss including cable loss and 

splice losses for the FP115040U/H when used for perimeter intrusion 
detection applications is 9.6 dB

• the maximum allowable total span loss including cable loss and 
splice losses for the FP115040U/H when used for pipeline or data 
conduit TPI applications is 12 dB
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Material/size/weight/length/
bend radius

• flexible innerduct - high density polyethylene
• OD 42.2 mm (1.66 in.); ID 35.3 mm (1.39 in.)
• wall thickness 3.12 mm (0.12 in.)
• 394 kg/km 265 (lb/kft)
• maximum continuous length 1829 m (6000 ft.)
• min. bend radius 46 cm (18 in.)
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Target resolution • 15 m (50 ft.) for non cut-immune configurations, 30 m (100 ft.) for 
cut-immune configurations

location accuracy • 4 m (13 ft.) in a quiet environment

Virtual alarm zones • 1440 distinct software defined alarm zones per sensor unit

Cable cut • reported and located to within 30 m (98 ft.)
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Disturbance Threshold • the minimum level that a localized disturbance must reach to be 
accumulated and counted towards alarm generation, default = 5

Alarm Threshold • the minimum disturbance count that must accumulate in a location 
range and a time range in order to generate an alarm, default = 10

Duration Threshold • the minimum event duration (in seconds) required in order to declare 
an alarm, default = 0 (disabled)

Disturbance Life • the length of time, in seconds, for which any localized disturbance is 
retained, default = 15 s

Disturbance Mask • used to prevent a single disturbance event from being recorded as 
additional disturbances due to continuing reverberations caused by 
the initial disturbance, default = 0.3 s

Disturbance Range • defines the length of cable over which a current disturbance event 
can be added to by additional disturbances in the same general area 
default = 12 m

Event Life • the length of time, in seconds, after which an event is complete, 
provided that no additional disturbance has occurred within the 
localized area of the event, default = 60 s

Environment Compensation • used to help screen out environmental factors like wind gusts and 
heavy precipitation that can cause nuisance alarms

• Spatial Environment Compensation monitors disturbance signals 
over a longer length of the sensing cable and removes common-
mode disturbance signals caused by environmental factors

• Temporal Environment Compensation works at a localized point of 
the sensor and removes background signals based on the point’s 
history over a time period

Parallel motion rejection • used to prevent nuisance alarms caused by nearby vehicles or trains 
moving alongside the sensor cable, and by planes taking off and 
landing alongside fences at airports

Perpendicular motion 
rejection

• used to prevent nuisance alarms caused by vehicles approaching 
the sensor cable directly, or passing through frequently used gates, 
and by planes passing over fences at airports
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c Location/calibration table

tap point # description time/location 1 time/location 2 time/location 3 avg. location
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test point # description/GPS coordinates time/location 1 time/location 2 time/location 3 avg. location
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d Remote Alarm Output

Network Manager Alarm reporting Setup

In the default configuration, the FiberPatrol sensor unit provides a TCP/IP server with one 
available connection for interfacing to a remote security management system (SMS). Additional 
connections can be configured (restrictions apply). 

• Transmission Protocol TCP

• Interface Mode Server

• Number of Connections 1 or more

• Default Port 4122

• Report Mode 0

• Data Formatting XML version 1.0

• XML Namespace Proprietary

• Text Encoding US-ASCII

Communication content

A standard FiberPatrol alarm report incorporates the following information:

• Device identification: site ID (internal), unit ID (internal), description (optional)

• System information: time stamp, system operational status

• Pre-alarm condition (optional)

• Alarm information: alarm ID (internal), time tamp, location (sensor location, GPS, and/or 
zone), event parameters (type, magnitude, duration, etc.)

• Alarm clearing notifications acknowledgments

The FiberPatrol remote communication interface accepts command messages that enable remote 
clients to perform the following operations:

• Clear alarms (by reference ID, by zone, clear all)

• Request alarm reports for expired alarms

Note For Network Manager alarm reporting the most common Report Mode is 
either 0 or 6.

Note Each FiberPatrol Zone name must begin with an integer when used with 
the Network Manager. The available range of zones is 1 to 480.
e.g., (1:Zone1, 2:Zone2, 3:Zone3, etc.)



Page 144 FiberPatrol FP1150 Product Guide

• Query/modify basic detection settings

• Query/modify zone assignments, add/delete zones

• Query/modify zone-specific detection settings

• Modify interface parameters (enable/disable reporting, set reporting interval, select report 
mode)

Communication timing

By default, FiberPatrol alarm reports are transmitted approximately once per second. When a new 
alarm is generated, a report with the new alarm information is transmitted immediately. Alarm 
information is transmitted for as long as an alarm is active (typically, for the duration of an event 
plus 60 seconds). The reporting interval is adjustable. Continuous reporting can be disabled, in 
which case an alarm report must be requested by a query command.
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